
How to begin a new video production

Procedure

1. Click the NEW icon on the Toolbar.    

or

1. Click the MENU button at the top of the Toolbar.

2. Select STORYLINE, then NEW in the menus and sub-menus displayed.

A new video production is initiated. You will be prompted to save any unsaved production currently underway. The Storyline 
is cleared of any video scenes and transitions residing there.



How to open a previously saved Storyline

Procedure

1. Click the OPEN icon on the Toolbar.    

or

1. Click the MENU button at the top of the Toolbar.

2. Select STORYLINE, then OPEN in the menus and sub-menus displayed.

The Open file selector is displayed from which an existing storyline can be selected. MGI VideoWave storyline files 
have the extension, .SBD.

Notes

1. Saved storylines (extension .sbd) are “Works in Progress”. These files can be edited. Video files that have been 
“produced” (extensions .avi, .mpg, etc.) cannot be edited. For this reason, these files cannot be “opened”.

2. If a storyline is currently open on your screen, you will be prompted to save any unsaved changes to the existing 
storyline before another one is opened.

See Also

Saving and producing your video



How to save and produce a video

To save the Storyline:

You can save one file in the Storyline, a series of files in the Storyline (including any transitions between them), or the 
entire Storyline itself as a Work in Progress. This work in progress is saved as a VideoWave .SBD file that you can later re-
open to continue your editing. If your selection has not yet been named and saved, the Save As file selector is displayed for 
you to assign a name and path to the file.

Procedure

1. Select the file or files in the Storyline you wish to save.

Note
To save a series of files, select the first file in the series. Hold down the SHIFT key, and select the last file in the 
series. Your selection is highlighted.

To save the entire Storyline:

Select the first file in the Storyline, then holding down the SHIFT key, select the last file in the Storyline.

or

Click the Menu button at the top of the Toolbar, and choose SELECT ALL from the Edit menu.

or

Press the shortcut keys, CTRL + A.

2. Click the SAVE icon on the Toolbar.

or
Click the Menu button at the top of the Toolbar, and select SAVE (or SAVE AS if it is a new, unnamed selection) from the Storyline 
menu.
or
Right-click your selection in the Storyline, and select SAVE PANELS from the menu displayed.

If your selection has not yet been named and saved, the Save As file selector is displayed for you to assign a name 
and path to the file.

To produce a video:

Selected files in the Storyline, or the entire Storyline itself, are produced in final playback format (ie; AVI, MPEG-1, MPEG-
2). Once the selection is produced, it cannot be edited. If you wish to continue editing, you must re-open the SBD file, 
complete the editing process, and produce the video again.

Procedure

1. Select the file or files in the Storyline you wish to produce. If you wish to produce a video consisting of all files in the 
Storyline, you do not have to select the files first before performing Step 2.

Note
To produce a series of files, select the first file in the series. Hold down the SHIFT key, and select the last file in the 
series. Your selection is highlighted. The series must be continuous.

2. Click the PRODUCE icon on theToolbar.

or
Click the Menu button at the top of the Toolbar, and select PRODUCE from the Storyline menu.
The Produce     Movie   wizard is launched to guide you through the production process. For a description of this dialog, see “Produce 
Movie” below.

3. Specify which part of the Storyline is to be produced.



Note
If you are producing a video consisting of all files in the Storyline, make sure the ENTIRE STORYLINE control is 
selected.

If you are producing a video consisting only of the files selected in Step 1, make sure the HIGHLIGHTED CLIPS 
ONLY control is selected.

4. Select a PRODUCE TEMPLATE from the list provided. A template consists of a number of predefined settings chosen
and tested by MGI. A description of each template is given.

Note:
If you wish to create your own template, or edit an existing one, click the CREATE or EDIT buttons, respectively. For 
more information about creating templates, see How to create a Produce template.

5. Click the NEXT button. A Summary of your settings is displayed before you commence production.

6. Verify the settings in the Summary dialog, and click the PRODUCE button to proceed with production. If you wish to 
make changes, click the BACK button to return to the previous panel.

To produce to a DV file:

If you are producing to a DV file from DV source material, MGI VideoWave III employs SmartDVÔ, which can greatly 
reduce the time required to produce the final video.

With SmartDVÔ, VideoWave III can produce the DV file directly without re-rendering the frames provided the DV file 
has not had any effects or transitions applied. Without SmartDVÔ, each frame that is produced must be re-rendered, 
even if no effects, such as text or special effects, have been added. With SmartDVÔ, re-rendering does not take 
place in sections of DV footage that do not contain applied effects. Under these conditions, much faster production will
result.

See Also

Considerations before saving your video production 



How to create a Produce template

To create a Produce template:

1. Click the CREATE button on the Produce Movie panel. The Create Produce Template dialog is displayed.

2. Assign a name to your new template in the TEMPLATE NAME field.

3. If you wish, record a description of your new template for future reference. A large TEMPLATE DESCRIPTION text 
field is provided for this purpose.

4. Select a FILE TYPE from the list provided. A description of each type is given.

5. Click the NEXT button to advance to the next panel.

6. Select a video CODEC from the list provided. A description of each option is given.

Note:
A video CODEC is a compression technology that reduces the size of a video file by selectively compressing the image 
data. Compressed files are more compact, but offer reduced image quality. Compressed video files may play back more 
smoothly on slow hard disks or CD ROM drives.
Low compression rates result in higher quality video but larger files. High compression rates result in lower quality video 
but smaller files. The video CODECs listed are those that have been installed on your system.

A QUALITY slider is available with some video CODECS (like Indeo). Use the slider to control image quality, with 100% 
being the best.

7. If you wish, specify the point at which a KEY FRAME, or reference frame for compression purposes, is designated.

Note:
Key Frame is the technical term used to describe how a particular video CODEC compresses video. Many video 
CODECS use a technique called "interframe compression" to drastically cut down on the size of a video file. Only 
information about the changes that occur from one frame to another is stored. For example, if you had a video of 
someone sitting at a desk talking, and the camera wasn't moving, the only thing that would change from one frame to the 
next would be the person’s face. A video compressor that has interframe compression would take advantage of this by 
storing the graphical information that doesn't change from frame to frame (like the desk, the background, etc) only once 
as a "key frame", and then storing only the parts of the image that change from frame to frame. After a while though, 
things will have changed enough that the compressor will need to create a new key frame. The more key frames you 
have, the bigger the final video file will be. The fewer key frames you have, the smaller the file will be, but at the expense 
of image quality.

8. If you wish, specify a DATA RATE to match the expected data rate of the playback device, i.e, hard disk, CD-ROM. 
Low data rates mean more compression and smoother playback on slow devices – all at the expense of quality, 
however.

9. Choose a FRAME SIZE from the list provided.

Note:
Studio-quality frame size for digital video is 720 x 480 (NTSC) or 720 x 576 (PAL/SECAM). With consumer equipment, 
however, horizontal sample rates can be reduced resulting in a frame size of 320 x 480 (NTSC) or 384 x 576 
(PAL/SECAM). This frame size still contains both fields of the interlaced video signal making it suitable for tape to tape 
edit. When the goal is to create video for playback on the computer screen, non-interlaced capture should be used. This 
is best achieved by capturing just one of two fields resulting in a frame size of 320 x 240 (NTSC) or 384 x 288 
(PAL/SECAM).

For Internet use, the standard frame size is 160 x 120. This size reduces memory requirements and download times over
phone lines.

10. Choose a FRAME RATE from the list provided.

Note:
The standard frame rate for TV is 29.97 fps (NTSC) or 25 fps (PAL, SECAM). For tape to tape edit this exact number 
must be used. For other media, like CDs and the Internet, 15 fps is usually acceptable and requires less storage space.

11. Specify a color depth for the video.

12. If you are attaching sound to your video, specify an AUDIO SAMPLE SIZE.

Note:
Audio sample size (in bits) affects the audio's dynamic range and signaltonoise ratio. A 16bit sample size is equivalent to 
that used in CD playback, and is preferred for music; 8bit is fine for dialogue. Audio can have a large impact, so if it's 
important to your video, you may want to use the 16bit setting to maintain fidelity and minimize noise.

Stereo audio takes up twice the storage room of monaural audio. If your audio track is stereo and consists mainly of 
dialogue (rather than music) consider changing it to mono.



The setting, BEST SOURCE FORMAT, will allow VideoWave to choose the best audio format from all the clips in the 
current production, and use that as the audio source for the new produced file.

13. Select the control, ADJUST AUDIO INTERLEAVE FOR CD-ROM, if the produced file is to be played back from a CD-
ROM. You must select this control so that the audio and video will be properly synchronized.

14. Click the FINISH button to create the template. If ever you wish to edit the settings for this template, click the EDIT 
button in the PRODUCE MOVIE dialog.











How to load the files that will make-up the video

Before you begin to produce your video, you must choose which source media files, or clips, you wish to include in your 
Storyline. The files you choose will form the basis of your video production. From there, clips can be edited to create 
scenes.

Most often, files are browsed from sources such as your hard disk or CDROM, and are first loaded into the Library. From 
there, files can be arranged in the Storyline at will. If you wish, you can load files into both the Storyline and the Library at 
the same time.

To load files into both the Storyline and the Library:

1. Right-click an empty panel in the 
Storyline.

2. Select INSERT VIDEO from the menu 
displayed. The Get     Source   file selector 
is displayed.

3. Browse you hard disk or CD-ROM, and 
doubleclick the desired file. The file is 
loaded into both the Storyline and the 
Media Library. Only one file can be 
loaded at a time.

To load files into the Library:

1. Right-click anywhere inside the Library,
or click the small triangle in the top right 
corner.

2. Select ADD FILES from the menu 
displayed.

Note:
If you right-clicked a file in the Library, 
an expanded version of the menu is 
displayed.

3. Using the Open file selector, browse 
your hard disk or CDROM for files to 
load into the Library.

To load files into the Library using the menuing system:

1. Click the MENU button at the top of the Toolbar.

2. Point at LIBRARY in the menu displayed. Select ADD FILES from the sub-menu displayed.

3. Using the Open file selector, browse your hard disk or CDROM for files to load into the Library.

Note:

Files need not be loaded one by one. You can select several files within the Open file selector and load them together 
as group.











How to transfer files to the Storyline

The Storyline is where you assemble your video production, combining video clips/scenes, transitions, text, and special 
effects. To create a video production, arrange your video clips/scenes in the slots, and then select transitions to use 
between them.

To transfer a file to the Storyline:
1. Right-click an empty panel in the Storyline.

2. Select INSERT VIDEO from the menu displayed. The Get     Source   file selector is displayed. Note that you can load 
still images as well as video files.

3. Browse you hard disk or CD-ROM, and doubleclick the desired file. The file is loaded into both the Storyline and the 
Library.

or

1. Drag the file from the Library, and drop it into an empty panel in the Storyline.

or

1. Select an empty panel in the Storyline.

2. Right-click the desired file in the Library.

3. Select INSERT INTO STORYLINE from the Library menu displayed.

or

1. Select an empty panel in the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. Point at STORYLINE in the menu displayed.

4. Select INSERT VIDEO from the sub-menu displayed.

See Also

Manipulating files and transitions in the Storyline 



How to manipulate files and transitions in the Storyline

Extending the Storyline:

As you fill the slots, you can scroll the Storyline horizontally to add more files and transitions. To scroll, move the mouse 
pointer over the Storyline until the cursor changes to a “hand”. Click and hold with the left mouse button, and then move the
Storyline to the left or right. The following keys can be used to navigate the Storyline:

[Page Up] Scrolls back one complete width of the screen.

[Page Down] Scrolls forward one complete width of the screen.

[Home] Scrolls back to the first file in the production.

[End] Scrolls forward to the last file in the production.

[Left Arrow] Scrolls back one file or transition.

[Right Arrow] Scrolls forward one file or transition.

Right-clicking a scene in the Storyline:

Rightclick a single, filled panel in the Storyline and a 
menu is displayed offering several options. You can 
CUT, COPY, and PASTE files to and from the 
Clipboard to rearrange your Storyline, as well as 
REMOVE files entirely or undo the last operation 
performed.

Select EDIT/PREVIEW to transfer a file to the 
Viewscreen and begin editing.

Select SAVE PANEL to save a Storyline panel and 
add it to the Library.

Select PROPERTIES to see a wide array of statistics 
associated with a file.

See Also

How to save and produce a video 

Right-clicking a transition in the Storyline:

If you rightclick a filled transition in the Storyline, a 
similar menu is displayed. Select EDIT TRANSITION, 
and the Transition Editor console will be opened 
below the Viewscreen.

See
Transition Effects 



Right-clicking a series of files:

Rightclick a series of filled panels (including any 
transitions between them) in the Storyline and a menu
is displayed offering several options. You can cut, 
copy, and paste files to and from the Clipboard to 
rearrange your Storyline, as well as delete files 
entirely or undo the last operation performed.

Select PREVIEW to transfer the files to the 
Viewscreen.

Select SAVE PANELS to begin to create a final 
production of the selected files.

See
How to save and produce a video 

Rearranging the file order:

Once files and transitions have been placed in the Storyline, you can rearrange them in any order you wish. Simply drag an 
item, and drop it at the desired location. If you drop one item over top of another, the second item (and everything after it) 
will be shifted one slot to the right.

Editing source material in the Storyline:

Drag the file in the Storyline that you wish to edit, and drop it into the Viewscreen. Alternatively, right-click a file, and select 
EDIT/PREVIEW from the menu displayed. From there, use any of the various modes in the Mode selector to edit the file.

See Also

Mode selector 

Transferring files to the Storyline 





How to transfer files to the Viewscreen

Video files are transferred to the Viewscreen for editing purposes and to preview the work in progress prior to production.

Note
You can transfer more than one file at a time from the Storyline to the Viewscreen by holding down the [Shift] key as the files
are selected.

However, you can only transfer one file from the Library to the Viewscreen at any one time.

Procedure

1. Drag and drop the video file from 
the Storyline or Library to the 
Viewscreen.

or

1. Double-click the file in the 
Storyline or Library.

or

1. Right-click the file in the Storyline 
or Library.

2. Select EDIT/PREVIEW from the 
menu displayed.

or

1. Select the file in the Storyline or the Library.

2. Click the Menu button at the top of the Toolbar.

3. Point at EDIT in the menu displayed.

4. Select EDIT/PREVIEW from the sub-menu displayed.



How to play a video file

Similar to a VCR, the Control panel includes buttons for playback, pause, record, etc., used to preview clips, scenes, transitions, or 
your entire video, prior to final production.

Play
Plays the selected file in the 
Viewscreen.

Pause
Pauses the selected file displaying 
a freeze-frame in the Viewscreen.

Stop
Stops the playing of the file and 
returns to the file's first frame.

Loop
Plays the selected file or transition 
in a continuous loop.

First Frame ( To Head )
Returns to the first frame of the file.

Previous Frame ( Step Back )
Backs up the file one frame at a 
time.

Next Frame ( Step Forward )
Advances the file one frame at a 
time.

Last Frame ( To Tail )
Advances to the last frame of the 
file.

Duration
Indicates the time elapsed in minutes, seconds, 
and thousandths of a second as the file is 
played.

Time slider
Indicates graphically how far the file has run. Use
the slider to advance or rewind the file.

How to change the beginning and end points of a file

Use the Mark In / Mark Out-Point buttons on the Control panel to define the portion of the file you want to use. You can set 
the beginning and end points of a file as a whole, or the beginning and end of any effects you may add to a file.

You can find the exact frames you want the file to begin and end with by moving the round, brown sphere on the 
Time     slider   and the NEXT and PREVIOUS buttons on the Edit Console.



Note
You can mark In and Out points to identify the portion of the file you wish to use for the current production, but at the same 
time maintain the entire file as a whole.

You can also mark the In and Out points and click the EXTRACT…VIDEO button in the Cutting     Room   interface to discard 
permanently the portions of the file before and after the points.

Mark In / Mark Out-points

Mark In-Point
1. Move the round, brown sphere on the Time     slider  , and watch the frames on the Viewscreen. Click the NEXT and 

PREVIOUS buttons to advance or backup the file one frame at a time.

2. Stop at the frame with which you wish the video to begin.

3. Click the Mark In-Point button. This sets the beginning of the file, omitting the portion of the file before that point.

Mark Out-Point
1. Move the round, brown sphere on the Time     slider  , and watch the frames on the Viewscreen. Click the NEXT and 

PREVIOUS buttons to advance or backup the file one frame at a time.

2. Stop at the frame with which you wish the video to end.

3. Click the Mark Out-Point button. This sets the end of the file, omitting the portion of the file after that point.



How to cut Storyline files and transitions to the Clipboard

Procedure

1. Select a video file or transition on the Storyline, and click the CUT icon on the Toolbar.

or
1. Select a video file or transition on the Storyline, and press the shortcut keys CTRL + X.

or

1. Select a video file or transition on the Storyline.

2. Click the Menu button at the top of the Toolbar, and select CUT from the Edit menu.

or

1. Right-click a video file or transition on the Storyline, and select CUT from the Storyline menu displayed.

The selected video file or transition is cut from the Storyline and stored on the Clipboard.

Note
You can also cut a series of video files and any transitions between them. Select the first file in the series, and then holding 
down the SHIFT key, select the last file in the series. Cut the series from the Storyline using any of the methods listed above.



How to copy Storyline files and transitions to the Clipboard

Procedure

1. Select a video file or transition on the Storyline, and click the COPY icon on the Toolbar.

or
1. Select a video file or transition on the Storyline, and press the shortcut keys CTRL + C.

or

1. Select a video file or transition on the Storyline.

2. Click the Menu button at the top of the Toolbar, and select COPY from the Edit menu.

or

1. Right-click a video file or transition on the Storyline, and select COPY from the menu displayed.

The selected video file or transition is copied to the Clipboard.

Note
You can also copy a series of video files and any transitions between them. Select the first file in the series, and then 
holding down the SHIFT key, select the last file in the series. Copy the series using any of the methods listed above.



How to paste the contents of the Clipboard to the Storyline

Procedure

1. Select the video or transition panel on the Storyline into which you wish to paste the Clipboard contents.

2. Click the PASTE icon on the Toolbar.

or
1. Select the video or transition panel on the Storyline into which you wish to paste the Clipboard contents.

2. Press the shortcut keys CTRL + V.

or

1. Select the video or transition panel on the Storyline into which you wish to paste the Clipboard contents.

2. Click the Menu button at the top of the Toolbar, and select PASTE from the Edit menu.

or

1. Right-click the video or transition panel on the Storyline into which you wish to paste the Clipboard contents, and 
select PASTE from the menu displayed.

The contents of the Clipboard are pasted. If you select a filled slot into which to paste the contents, everything currently 
residing to the right of the selected slot shifts and follows the contents.



How to delete items from the Storyline

Procedure

1. Select a video file or transition on the Storyline, and click the DELETE icon on the Toolbar.

or
1. Select a video file or transition on the Storyline, and press the shortcut key DELETE.

or

1. Select a video file or transition on the Storyline.

2. Click the Menu button at the top of the Toolbar, and select DELETE from the Edit menu.

or

1. Right-click a video file or transition in the Storyline, and select REMOVE from the menu displayed.

The selected video file or transition is deleted.

Note
You can also delete a series of video files and any transitions between them. Select the first file in the series, and then 
holding down the SHIFT key, select the last file in the series. Delete the series using any of the methods listed above.



How to cut files from the Library to the Clipboard

Procedure

1. Select a file in the Library, and click the CUT icon on the Toolbar.

or
1. Select a file in the Library, and press the shortcut keys CTRL + X.

or

1. Select a file in the Library.

2. Click the Menu button at the top of the Toolbar, and select CUT from the Edit menu.

or

1. Right-click a file in the Library, and select CUT from the menu displayed.

The selected file is cut from the Library and stored on the Clipboard.

Note
You can only cut one file at a time.



How to copy Library files to the Clipboard

Procedure

1. Select a file in the Library, and click the COPY icon on the Toolbar.

or
1. Select a file in the Library, and press the shortcut keys CTRL + C.

or

1. Select a file in the Library.

2. Click the Menu button at the top of the Toolbar, and select COPY from the Edit menu.

or

1. Right-click a file in the Library, and select COPY from the menu displayed.

The selected file is copied to the Clipboard.

Note
You can only copy one file at a time.



How to paste the contents of the Clipboard to the Library

Procedure

1. Click the PASTE icon on the Toolbar. If the contents of the Clipboard consist of a produced file, the file is pasted to 
the Library.

or
1. Press the shortcut keys CTRL + V.

or

1. Click the Menu button at the top of the Toolbar, and select PASTE from the Edit menu.

or

1. Right-click anywhere inside the Library, and select PASTE from the menu displayed.

The contents of the Clipboard are pasted.



How to delete files from the Library

Procedure

1. Select a file in the Library, and click the DELETE icon on the Toolbar.

or
1. Select a file in the Library, and press the shortcut key DELETE.

or

1. Select a file in the Library.

2. Click the Menu button at the top of the Toolbar, and select DELETE from the Edit menu.

or

1. Right-click a file in the Library, and select DELETE from the menu displayed.

Note
You can delete more than one file at a time. Select the first file in the series, and then holding down the SHIFT key, select 
the last file in the series. Delete the series using any of the methods listed above. If files marked for deletion lie outside a 
series, hold down the CTRL key when selecting them.



How to rename files

Procedure

1. Right-click a file in the Library, and select RENAME in the menu displayed.

or

1. Select a file in the Library.

2. Click the Menu button at the top of the Toolbar, and select RENAME from the Edit menu.

or

1. Right-click a video file(s) in the Storyline, and select SAVE PANEL(S) in the menu displayed.

or

1. Select a video file in the Storyline.

2. Click the Menu button at the top of the Toolbar, and select RENAME from the Edit menu.

The Save     As   file selector is displayed allowing you to assign a new name and path (if you wish) to your file.



How to get detailed information about a file

Procedure

1. Right-click a file in the Library, and select PROPERTIES in the menu displayed.

or

1. Right-click a video file on the Storyline, and select PROPERTIES in the menu displayed.

or

1. Select a video file on the Storyline.

2. Click the Menu button at the top of the Toolbar, and select PROPERTIES from the Edit menu.

or

1. Right-click a video file in the Viewscreen, and select PROPERTIES in the menu displayed.

The Properties dialog is displayed. The dialog consists of two panels, File Properties and Edit Properties.

Note:

The fields in the Properties dialog are uneditable. Details are listed for information purposes only.

File Properties

Click the File Properties tab to display the panel.

File Details

Lists the scene’s general properties such as the scene’s name and duration, data rate, file size, and the date the scene
was produced.

Video Details

Lists the scene’s video properties such as frame size, frame rate, color depth, and the compressor used to create the 
scene.

Audio Details

Lists any audio file that may be associated with the scene.

Edit Properties

Click the Edit Properties tab to display the panel.

Time

Describes any marked In (start) and Out (end) points applied to the file, as well as the file’s duration. The Panel Start and 
Panel End values indicate where in the Storyline the file resides.

Effects

Indicates whether or not any special, text, or color effects have been applied to the file. The current status of the Scaling 
attribute, as set through the Preferences dialog, is also indicated.

Video animation effects can be added to a file through the Video Animator. If any effects have been added, the properties of 
the associated video file used to create the effect can be viewed here. Click the Properties button to view the information.

See Also

Video     Animator   

Text Animator 

Preferences dialog

Audio Tracks

The properties of any audio files associated with the video file can be viewed here. Click the Properties button to view the 



information.



How to add Storyline files to the Library

Procedure

1. Select an edited video file, or scene, on the Storyline.

2. Click the Menu button at the top of the Toolbar, and select SAVE PANEL(S) from the Edit menu.

or

1. Right-click a video file in the Storyline, and select SAVE PANEL from the menu displayed.

The Save     As   file selector is displayed. Assign a name and path to your video file, and click Save to save it. It is not 
necessary to type the file extension. Scenes are automatically assigned the extension .scn. The file is added to the Media 
Library currently open on your screen.



How to extract an image of a single frame

Procedure

1. Transfer the video file from either the Storyline or the Library to the Viewscreen.

See
How to transfer files to the Viewscreen 

2. Click the Cutting     Room   button on the Mode selector. The Cutting     Room     console   is displayed below the 
Viewscreen.

3. Use the Control panel to advance to the desired frame in the video scene.

Note:

First use the Time Slider to advance quickly to the general location of the frame. Then use the Previous     /     Next   
Frame buttons to advance to the precise location one frame at a time.

4. On the Cutting Room console, located below the Viewscreen, click the IMAGE button. The Extract     Images   dialog is 
displayed.

5. Click the BROWSE button to open the Save     As   file selector.

6. Assign a name and path to the image file to be extracted. Extracted images can be saved in JPG, BMP or TIF 
format.

Auto Rename

Select this control for continuous image extraction. File names are appended with incrementing numeric values. 
Example: Filename_001, Filename_002, and Filename_003.

Add to Storyline

Select this control to add the image to the Storyline upon extraction.

7. Click TO CLIPBOARD to copy the image to the Clipboard, or click EXTRACT to add the image to the Library.

Note:

To every still image is attached a time, or duration, attribute (expressed as a value). This value specifies the number of 
seconds a still image remains on the screen when it is part of a video production. By default, the setting is 5 seconds. To 
specify a different value, see the TOOLBAR menu item, Still     Image     Duration  .



How to extract a sound file currently attached to a video file

Procedure

1. Transfer the video file from either the Storyline or the Library to the Viewscreen.

See
How to transfer files to the Viewscreen 

2. Click the Cutting     Room   button on the Mode selector. The Cutting     Room     console   is displayed below the 
Viewscreen.

3. On the Cutting Room console, click the AUDIO button . The Save     As   file selector is displayed.

4. Using the file selector, assign a name and path to the audio file to be extracted. Extracted sound files are saved in 
WAV format.

5. Click SAVE to extract and save the file. The file is added to the Audio panel of the active Library as well.



How to extract a portion of a video file

Procedure

1. Transfer the video file from either the Storyline or the Library to the Viewscreen.

See
How to transfer files to the Viewscreen 

2. Click the Cutting     Room   button on the Mode selector. The Cutting     Room     console   is displayed below the 
Viewscreen.

3. Use the Edit Console to advance to the frame in the video that you wish the new clip to begin with.

Note:

First use the Time Slider to advance quickly to the general location of the frame. Then use the Previous     /     Next   
Frame buttons to advance to the precise location one frame at a time.

4. Click the Mark     In-Point   button.

5. Advance to the frame in the video that you wish the new clip to end with.

6. Click the Mark     Out-Point   button.

Note:

It is the portion of the video between the In-point and Out-point that is saved; everything else is discarded. The file 
held in the Library (on your hard disk) is not altered. You will be prompted to save the file under a new file name.

In and Out-points can be removed or changed by simply resetting them. To reset the points, hold the SHIFT key while 
clicking the mouse at the new locations.

Note:

The length of the extracted scene (the length in seconds between the In and Out-points) is displayed in the Duration 
value field.

7. On the Cutting Room console located below the Viewscreen, click the VIDEO button. The Save     As   file selector is 
displayed.

8. Using the file selector, assign a name and path to the video file to be extracted. Extracted files are saved in AVI format.

9. Click SAVE to extract and save the file. The file is added to the Video panel of the active Library as well.

Note:

Trimming, or extracting, is especially useful for removing unwanted frames at the beginning and end of a captured file.
One important benefit of keeping only files and portions of files you will need for the production is greatly reduced disk
space usage.



How to split video files in two

Procedure

1. Transfer the video file from either the Storyline or the Library to the Viewscreen.

See
How to transfer files to the Viewscreen 

2. Click the Cutting     Room   button on the Mode selector. The Cutting     Room     console   is displayed below the 
Viewscreen.

3. Use the Edit Console to advance to the frame in the video at which you wish to split the scene.

Note:

First use the Time Slider to advance quickly to the general location of the frame. Then use the Previous     /     Next   
Frame buttons to advance to the precise location one frame at a time.

4. On the Cutting Room console located below the Viewscreen, click the SPLIT button. Thumbnails representing the two 
portions of the split scene are displayed on the Storyline.

Note:

The length of the extracted scene (the length in seconds between the In and Out-points) is displayed in the Duration 
value field.

Note:

Often scenes are split in order to insert a transition between the two portions. For more information about transitions, 
see Transition     Effects   



Toolbar

Use the Toolbar on the left side of the screen to quickly access a number of commonly used functions. These functions 
can also be accessed from drop-down menus. Click the Menu button at the top of the Toolbar to access the menus.

New Production
Initiates a blank Storyline.
See New 

Open Production
Opens a previously saved production.
See Open 

Save
Saves the Storyline as a “Work in 
Progress”.
See Save 

Produce Video
Converts the Storyline to a video file in 
standard playback format (AVI, MPG, 
MOV).
See Produce 

Cut
Cuts a selected video clip or transition from 
the Storyline, or a file from the Media 
Library, and stores it on the Clipboard.
See Cut - Storyline 

Cut   –   Library   

Copy
Copies to the Clipboard a selected video 
clip or transition in the Storyline, or a 
selected file in the Media Library.
See Copy - Storyline 

Copy   –   Library   

Paste
Pastes the contents of the Clipboard to 
a selected clip or transition box in the 
Storyline, or to the Media Library.
See Paste - Storyline 

Paste   –   Library   



Delete
Deletes a selected video clip or transition in 
the Storyline, or a selected file in the Media 
Library.
See Delete - Storyline 

Delete   –   Library   

Undo
Undoes the last operation performed.
See Undo 

Mode Selector

Use the modes, or tools, on the Mode selector to customize your video production. The Selector is located to the left of the
Viewscreen. After a button within the Selector is clicked, a Video Mode console is added below the Viewscreen. The 
console, or interface, added represents options specific to the particular mode selected.

Cutting Room 
Mark In and Out points. Split and trim video
files. Extract sound files and still images.

Dark Room 
Adjust brightness, contrast, and color of 
video files.

Special Effects 
Choose from a number of special effects to 
add to your video files.

Text Animator 
Customize your video with text animation 
effects.

Transition Effects 
Choose from a number of transition effects 
to join your video files.

Video Animator 
Blend one file with another for professional-
looking, video effects.

Audio Studio 
Add one or two tracks of stereo audio to 
your production, and perform audio fades.



Output to Video 
Output your production to video tape, or 
view the production full-screen on your 
monitor.

Capture 
Capture analog and digital video, images, 
and audio from outside sources such as a 
TV, VCR, Camcorder or Laserdisc player.

Black/Red Indicators

A small indicator is located beside each button in the Mode selector. If the indicator beside a button is colored black, it 
indicates that no settings have been altered in this mode. If the indicator beside a button is colored red, it indicates that 
settings have been altered and applied in this mode. This feature is useful if you wish to undo settings previously altered 
for a clip.



Edit Console

Similar to a VCR, the Control panel includes buttons for playback, pause, record, etc., used to preview clips, scenes, 
transitions, or your entire video, prior to final production.

Play
Plays the selected file in the Viewscreen.

Pause
Pauses the selected file displaying a freeze-frame in the 
Viewscreen.

Stop
Stops the playing of the file and returns to the file's first 
frame.

Loop
Plays the selected file or transition in a continuous loop.

First Frame ( To Head )
Returns to the first frame of the file.

Previous Frame ( Step Back )
Backs up the file one frame at a time.

Next Frame ( Step Forward )
Advances the file one frame at a time.

Last Frame ( To Tail )
Advances to the last frame of the file.

Duration
Indicates the time elapsed in minutes, seconds, and thousandths of a 
second, as the file is played.

Time slider
Indicates how far the file has run. Use the slider to advance or rewind the 
file.

Storyline

The Storyline is where you assemble your video production by combining video clips, scenes, transitions, text and special 
effects. The Storyline is comprised of panels, or boxes, of which there are two types; one to hold Clips and Scenes, and the 
other to hold Transitions. While only a few panels are viewable on the screen at any one time, you can have an unlimited 
number of scenes and transitions for longer video productions.

As you fill the panels, you can scroll the Storyline horizontally to add more clips, scenes and transitions. To scroll, move the 
mouse pointer over the Storyline until the cursor changes to a “hand”. Click and hold with the left mouse button, and then 
move the Storyline to the left or right.

To create a video production, you arrange all your video clips and scenes in the video panels of the Storyline, and then insert
transitions to use between them.



Note
Typically, you load source files first into the Library and then transfer and arrange them in the Storyline. The Library serves 
as a holding place for any number of files you can select for the Storyline and ultimately final video production.

See Also

Library 

Terminology

Clip

A single, source video or audio file that can be anywhere from less than a second to several minutes in duration.

Scene

A source file, or clip, that has been placed on the Storyline. Once a clip, edited or not, has been placed on the 
Storyline, the file is referred to as a scene.

Transition

Used to separate clips/scenes. Can be as short as a cut or longer, using fades, blends, etc.

File

Throughout the documentation video clips and scenes are referred together as video files.

Storyline

Your entire video production including scenes, clips, special effects, transitions, and sound saved as a “Work in 
Progress” (file extension .SBD) that can be opened and edited at a future date.

Video production

Your entire video production including scenes, clips, special effects, transitions, and sound saved in standard 
playback format (AVI, MOV, MPG). Video productions cannot be edited.

To transfer a file to the Storyline:

1. Right-click an empty panel in the Storyline.

2. Select INSERT VIDEO from the menu displayed. The Get     Source   file selector is displayed. Note that you can load 
still images as well as video files.

3. Browse you hard disk or CD-ROM, and doubleclick the desired file. The file is loaded into both the Storyline and the 
Library.

or

1. Drag the file from the Library, and drop it into an empty panel in the Storyline.

or

1. Select an empty panel in the Storyline.

2. Right-click the desired file in the Library.

3. Select INSERT INTO STORYLINE from the Library menu displayed.

or



1. Select an empty panel in the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. Point at STORYLINE in the menu displayed.

4. Select INSERT VIDEO from the sub-menu displayed.

To preview a Storyline file (s) in the Viewscreen:

1. Drag the file from the Storyline to the Viewscreen.

You can transfer more than one file at a time from the Storyline to the Viewscreen by holding down the [Shift] key as the files
are selected.

1. Hold down the [Shift] key, and select the desired files in the Storyline.

2. Release the [Shift] key.

3. Drag the files to the Viewscreen.

See Also

How to manipulate files and transitions in the Storyline 

How to play a video file 



Library

The Library acts as a holding place for your multimedia files. Files include clips (source files) and scenes (edited clips). As 
you proceed to edit and compose your video production by adding such items as text, transitions, and special effects, new 
panels are displayed in the Library as you need them. In other words, click a button in the Mode selector, and any panel that 
may be associated to the mode is added to the Library.

To load files into the Library:

1. Right-click anywhere inside the Library.

2. Select ADD FILES from the menu 
displayed.

3. Using the Open file selector, browse 
your hard disk or CDROM for files to 
load into the Library.

or

1. Click the MENU button at the top of the 
Toolbar.

2. Point at LIBRARY in the menu 
displayed. Select ADD FILES from the 
sub-menu displayed.

3. Using the Open file selector, browse 
your hard disk or CDROM for files to 
load into the Library.

Note:
Files need not be loaded one by one. 
You can select several files within the 
Open file selector and load them 
together as group.

The first menu shown above is the one displayed if you right-click anywhere inside the Library except on a file. If    you right-
click a file, the menu displayed is that shown below because existing files can have several operations performed upon them.

Once your files are loaded into the Library, you can easily place them onto the Storyline or the Viewscreen. Use the 
Viewscreen to preview the effects of any editing you may perform on a file. Use the Storyline to build your video production 
using a series of files and transitions.

To transfer a file from the Library to the Viewscreen:

Note
You can only transfer one file at a time from the Library to the Viewscreen.



1. Drag and drop the file from the Library to 
the Viewscreen.

or

1. Double-click the file in the Library.

or

1. Right-click the file in the Library.

2. Select EDIT/PREVIEW from the menu 
displayed.

To transfer a file from the Library to the Storyline:

1. Drag and drop the file from the Library to 
an empty panel in the Storyline.

or

1. Select an empty panel in the Storyline.

2. Right-click the file in the Library.

3. Select INSERT INTO STORYLINE from 
the menu displayed.

You can also create a Library file and then save it to your hard drive. This lets you draw from different Libraries to build each 
of your productions.

See Also

Saving a library file 

How to play a video file 









Menu Commands - Toolbar Menu

Click the MENU button at the top of the Toolbar. to open the Toolbar menu. The commands available are listed below. Many
commands have sub-menus of options associated with them. Click a command below to learn its use, or to view any options
that may be available.

Storyline 

Edit 

Library 

Preferences 

Help 

Exit 



Menu Commands - Toolbar Menu

Click a command below to learn its use, or to view any options that may be available.

Storyline New 

Open 

Save 

Save As 

Produce 

Find Panel 

Insert Video 

Create Color Panel 

Still Image Duration 

Recent File 

Edit 

Library 

Preferences 

Help 

Exit 



Menu Commands - Toolbar Menu

Click a command below to learn its use, or to view any options that may be available.

Storyline 

Edit Undo 

Cut 

Copy 

Paste 

Delete 

Select All 

Rename 

Edit / Preview 

Save Panel(s) 

Media Properties 

Library 

Preferences 

Help 

Exit 



Menu Commands - Toolbar Menu

Click a command below to learn its use, or to view any options that may be available.

Storyline 

Edit 

Library Add Files 

New 

Open 

Save 

Save As 

Show Thumbnails 

Preferences 

Help 

Exit 



New

To begin a new video production:

1. Click the Menu button at the top of the Toolbar.

2. On the Storyline menu, click NEW.

Note:

If a production is currently open on your screen, you are prompted to save any changes to the current production 
before you begin a new one.

Note:

You compose video productions on the Storyline at the top of your screen. As you compose, you can save the 
production periodically as a work in progress (.SBD file). An SBD file can be reopened at any time if you wish to 
continue composing or editing the video, or to produce final videos in a variety of formats. All the component data 
and files that make up a video production are saved with the SBD file. Any modification made to the production, or 
SBD file, can be undone.

After you have finished composing the video, you can produce, or save, it as a single production file in one of a 
number of video file formats (i.e; .AVI, .MPG, etc.) with all the benefits of data compression. Note, however, that 
produced files cannot be edited. They can, however, be used in the Storyline of other video productions you 
compose. If you wish to edit a video production, you must return to the SBD file, make the modifications, and 
reproduce the video.

Shortcut

Toolbar

See Also

How to begin a new video production 



Open

To open a previously saved Storyline file:

1. Click the Menu button at the top of the Toolbar.

2. On the Storyline menu, click OPEN.

Note:

If a Storyline is currently open on your screen, you are prompted to save any changes to the current file before you 
begin a new one.

3. Select a Storyline file using the Open file selector displayed. MGI VideoWave Storyline files have the extension .SBD.

Shortcut

Toolbar

See Also

How to open a previously saved Storyline 







Save

To save a video production as a work in progress:

1. Click the Menu button at the top of the Toolbar.

2. On the Storyline menu, click SAVE.

Note:

If the production has not yet been named and saved, the Save     As   file selector will be displayed allowing you to 
assign a name and path to your file. You do not have to type the VideoWave production file extension, .SBD. The 
extension will automatically be assigned for you.

Note:

You compose video productions in the Storyline at the top of your screen. As you compose, you can save the 
production periodically as a work in progress (.SBD file). An SBD file can be reopened at any time if you wish to 
continue composing or edit the video, or to produce final videos in a variety of formats. All the component data and 
files that make up a video production are saved with the SBD file. Any modification made to the production, or SBD 
file, can be undone.

After you have finished composing the video, you can produce, or save, it as a single production file in one of a 
number of video file formats (i.e; .AVI, .MPG, etc.) with all the benefits of data compression. Note, however, that 
produced files cannot be edited. They can, however, be used in the Storyline of other video productions you 
compose. If you wish to edit a video production, you must return to the SBD file, make the modifications, and 
reproduce the video.

Shortcut

Toolbar

See Also

How to save and produce a video 





Save As

To name and save a video production currently under construction:

1. Click the Menu button at the top of the Toolbar.

2. On the Storyline menu, click SAVE AS to save a new, untitled "work in progress" or to save an existing one under a 
new name.

3. Use the Save     As   file selector to assign a name and path to your file. You do not have to type the VideoWave file 
extension, .SBD. The extension will automatically be assigned for you.

Note:

You compose video productions in the Storyline at the top of your screen. As you compose, you can save the 
production periodically as a work in progress (.SBD file). Use the Save As command to first name and save the file.

An SBD file can be reopened at any time if you wish to continue composing or edit the video, or to produce final 
videos in a variety of formats. All the component data and files that make up a video production are saved with the 
SBD file. Any modification made to the production, or SBD file, can be undone.

After you have finished composing the video, you can produce, or save, it as a final production file in one of a 
number of video file formats (i.e; .AVI, .MPG, etc.) with all the benefits of data compression. Note, however, that 
produced files cannot be edited. They can, however, be used in the Storyline of other video productions you 
compose. If you wish to edit a video production, you must return to the SBD file, make the modifications, and 
reproduce the video.

See Also

How to save and produce a video 



Produce

To produce a movie based on the contents of the Storyline:

1. On the Storyline, select the video panels, and any transitions between them, that you wish to produce as a movie.

2. Click the Menu button at the top of the Toolbar.

3. On the Storyline menu, click PRODUCE to create a final production of the selected contents of the Storyline

4. Specify the desired attributes of the movie as you proceed through the Produce wizard. The Storyline is output to a 
video file in standard playback format (AVI, MPG, MOV).

Shortcut

Toolbar

See Also

How to save and produce a video 



Find Panel

To find a video panel on the Storyline:

1. Click the Menu button at the top of the Toolbar.

2. On the Storyline menu, click FIND PANEL. The Find     Storyline     Panel   dialog is displayed.

Note:

Video panels are numbered and identified by their file name. Transition panels are indented and identified by their type.
Technically speaking, video scenes reside in panels on the Storyline. As a result, you are attempting to find a video 
scene as much as a video panel.

3. In the dialog, click the video panel or transition you wish to advance to.

4. Click the Go To button to advance to the selected video panel or transition.

Preview

A thumbnail of the selected video panel or transition is displayed in the top right-hand corner of the dialog.

Properties

Click this button to view the properties associated with the selected video panel. This button is available to video 
panels only. The Properties dialog is displayed. For a description of this dialog, see Properties.





Insert Video

To insert a source video file into both the Storyline and Library:

1. Select the panel in the Storyline into which the file is to be inserted.

Note

If you select a panel that already contains a file, your new selection will replace the previous one. The previous file, and
any others that follow, will all be pushed one panel to the right.

2. Click the Menu button at the top of the Toolbar.

3. On the Storyline menu, click INSERT VIDEO. The Get Source file selector is displayed.

4. Select the desired video file, and click Open. The selected file is inserted onto the Storyline at the specified location.

See Also

How to transfer files to the Storyline 





Create Color Panel

Use this command to create a simple color panel, or background, onto which you can place text or that you can use in a 
video animation.

To create a color panel:

1. Select an empty panel on the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. On the Storyline menu, click CREATE COLOR PANEL. Immediately, you are brought to the Cutting Room.

4. Click the button labeled, COLOR. The Color selector is displayed.

5. Using the Color selector, specify the color you wish the background to be, and click OK.

6. The number of seconds that the panel is to remain on the screen is displayed in the numeric field labeled, DURATION. 
Click the plus (+) and minus (-) buttons to adjust the duration.

7. When you are satisfied with your settings, click Apply.

See Also

Adding text using the Text Animator 

Using the Video Animator 



Still Image Duration

To set the number of seconds that a still image(s) remains on the screen:

1. Click a still image panel(s) on the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. On the Storyline menu, click STILL IMAGE DURATION. Still     Image     Duration   dialog is displayed.

4. Choose whether to apply the setting specified here to all still images on the Storyline or only to those currently 
highlighted. The controls are ALL STILLS and HIGHLIGHTED STILLS ONLY, respectively

5. In the value field labeled, DURATION, specify the number of seconds that the stills are to remain on the screen.

See Also

Extracting still images in the Cutting Room 





Recent File

To see the most recently opened Storyline files:

1. Click the Menu button at the top of the Toolbar.

2. Point at Storyline. A list of the most recently opened SBD files, or “works in progress”, is displayed at the bottom of 
the menu.

3. Select a file in the list to open it.



Undo

To undo the last operation performed:

1. Click the Menu button at the top of the Toolbar.

2. On the Edit menu, click UNDO. Only one level of Undo is supported. Click the menu item a second time and the 
operation is redone.

Shortcuts

Toolbar

Keys CTRL + Z

Cut

To cut a video scene or transition from the Storyline and store it on the Clipboard:

1. Select the desired video scene or transition on the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. On the Edit menu, click CUT.

Shortcuts

Toolbar

Keys CTRL + X

See Also

How to cut Storyline scenes and transitions to the Clipboard 





Copy

To copy a video scene or transition to the Clipboard:

1. Select the desired video scene or transition on the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. On the Edit menu, click COPY.

Shortcuts

Toolbar

Keys CTRL + C

See Also

How to copy Storyline scenes and transitions to the Clipboard 



Paste

To paste the contents of the Clipboard to a video or transition panel in the Storyline:

1. Select the desired video or transition panel on the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. On the Edit menu, click PASTE.

Shortcuts

Toolbar

Keys CTRL + V

See Also

How to paste the contents of the Clipboard to the Storyline 



Delete

To delete a video scene or transition from the Storyline:

1. Select the desired video scene or transition on the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. On the Edit menu, click DELETE.

Shortcuts

Toolbar

Keys DELETE

See Also

How to delete items from the Storyline 



Select All

To select all    scenes and transitions in the Storyline:

1. Click the Menu button at the top of the Toolbar.

2. On the Edit menu, click SELECT ALL.

or

1. Right-click a video or transition panel in the Storyline.

2. On the Storyline menu, click SELECT ALL.

or

1. Click the first video panel in the Storyline.

2. Press the SHIFT key.

3. Click the last panel in the Storyline.

Note:

With this technique, you need not select the entire Storyline. If you wish, you can select any series of scenes within the
Storyline.

Common uses of this command:

· To save the entire Storyline as an SBD file for use in other video productions. Simply execute this command, and then 
drag the Storyline to the Library. The Save As file selector will appear prompting you to assign a name to the file. Once 
you have done so, the file will be added to the Library.

· To cut or copy the entire Storyline to the Clipboard.

· To view the entire video composition in the Preview screen. Simply execute this command, and then drag the Storyline 
to the Viewscreen. Click the Play button to view the production.



Rename

To rename a video scene:

1. Select the video scene in the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. On the Edit menu, click RENAME. In the Save     As   file selector displayed, assign a new name and path (if you wish) to 
the file. The Library file is renamed as well as any instances of it in the Storyline.

See Also

How to rename files 





Edit / Preview

To preview a video scene, or a series of scenes, including any transitions between them:

1. Select a video scene, or series of scenes, on the Storyline.

Note:

Technically speaking, you are selecting video panels within which the video scenes reside.

Note:

Source video files, whether or not they have been edited, are referred to as scenes once they are part of the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. On the Edit menu, click EDIT / PREVIEW. The first video scene selected is displayed in the Viewscreen ready for 
preview or any editing that may be required. If you wish to preview the scene(s), click the Play button on the Control 
panel. Each selected scene is played in sequence.

Shortcut

Drag and drop the video scene, or series of scenes, directly into the Viewscreen.

See Also

How to transfer video scenes to the Viewscreen 

How to select a series of video scenes 



Save Panel(s)

To save a Storyline panel(s) and add it to the Library:

1. Select a video panel, or series of panels, in the Storyline. 

Note:

Technically speaking, you are saving video scenes that reside in video panels.

Note:

A video file, or a series of files, is referred to as a scene once it is placed on the Storyline. Scenes include source video
files, edited video files, color panels, and a series of single scenes.

2. Click the Menu button at the top of the Toolbar.

3. On the Edit menu, click SAVE PANEL(S). The Save     As   file selector is displayed.

4. Assign a name and path to the file(s), and click Save to save it. The selection is saved and added to the currentlly 
active Library.

Note:

It is not necessary to type a file extension. Single video scenes are automatically assigned the extension .scn. A series
of scenes, including any transitions between them, is assigned the extension .sbd.The scene (or series of scenes) is 
added to the Library currently open on the screen.

See Also

How to add Storyline scenes to the Library

How to select a series of scenes 





Media Properties

To examine the properties of a selected scene:

1. Select the scene in the Storyline.

2. Click the Menu button at the top of the Toolbar.

3. On the Edit menu, click MEDIA PROPERTIES. The Properties dialog is displayed. The dialog consists of two panels, 
File Properties and Edit Properties.

Note:

The fields in the Properties dialog are uneditable. Details are listed for information purposes only.

File Properties

Click the File Properties tab to display the panel.

File Details

Lists the scene’s general properties such as the scene’s name and duration, data rate, file size, and the date the scene
was produced.

Video Details

Lists the scene’s video properties such as frame size, frame rate, color depth, and the compressor used to create the 
scene.

Audio Details

Lists any audio file that may be associated with the scene.

Edit Properties

Click the Edit Properties tab to display the panel.

Time

Describes any marked In (start) and Out (end) points applied to the file, as well as the file’s duration. The Panel Start and 
Panel End values indicate where in the Storyline the file resides.

Effects

Indicates whether or not any special, text, or color effects have been applied to the file. The current status of the Scaling 
attribute, as set through the Preferences dialog, is also indicated.

Video animation effects can be added to a file through the Video Animator. If any effects have been added, the properties of 
the associated video file used to create the effect can be viewed here. Click the Properties button to view the information.

See Also

Video     Animator   

Text Animator 

Preferences dialog

Audio Tracks

The properties of any audio files associated with the video file can be viewed here. Click the Properties button to view the 
information.

See Also

How to get detailed information about a file 







Add Files

To add source media files to the Library:

1. Click the Menu button at the top of the Toolbar.

2. On the Library menu, click ADD FILES. The Open file selector is displayed. Use this selector to locate and select the 
desired files to be added. Source files include video, audio, and still image files. Video and still image files are added to
the Video panel of the Library; audio files are added to the Audio panel of the Library.

See Also

How to load the files that will make-up the video 





New

To open a new library:

1. Click the Menu button at the top of the Toolbar.

2. On the Library menu, click NEW. A blank Library panel is displayed; the files displayed in the previous library are 
closed.





Open

To open an existing, previously saved library:

1. Click the Menu button at the top of the Toolbar.

2. On the Library menu, click OPEN. The Open file selector is displayed. Use this selector to locate and open the desired
file. Library files have the file extension .vwl.





Save

To save an existing, previously named library:

1. Click the Menu button at the top of the Toolbar.

2. On the Library menu, click SAVE.



Save As

To save a new Library file, or to save an existing one under a different file name:

1. Click the Menu button at the top of the Toolbar.

2. On the Library menu, click SAVE AS. The Save     As   file selector is displayed. Use this selector to specify the name and
path of the file. Library files have the file extension .vwl.





Show Thumbnails

To show thumbnails in the Library:

1. Click the Menu button at the top of the Toolbar.

2. On the Library menu, click SHOW THUMBNAILS. A small red sphere indicates when this feature is toggled on. 
Thumbnail representations of the media files listed in the Library are included.

Note:

Click SHOW THUMBNAILS again to toggle this feature off. Library files are listed by file name only.



Preferences

To specify your preferences, or options:

1. Click the Menu button at the top of the Toolbar.

2. On the menu, click PREFERENCES. The Preferences dialog is displayed consisting of two panels, the General panel 
and the Preview panel.

GENERAL PANEL

Display ToolTips

Select this control to display tooltips as the mouse is passed over icons.

Show Splash Screen on Startup

Select this control to view the MGI VideoWave product splash screen on loading the program.

Clear Library Contents on New Production

Select this control to clear all files from the Library when a new production, or storyline, is initiated.

Save Library with Production

Select this control to save the files within the Library when the video is produced. You will be prompted to assign a 
name and path to the library.

Open Last Production on Startup

Select this control to open on startup the last production, or storyline, worked on.

Default Clip Scaling Options

Scale to Frame

Select this option if you wish the scenes in your Storyline scaled to the frame size you choose in the Preview 
panel of this dialog.

Center in Frame

Select this option if you wish to center your scenes inside the frame.

Default Still Image Duration

A value specifying the number of seconds still images remain open on the screen.

Low Disk Level

Specify the threshold at which MGI VideoWave III advises you that you are low on disk space. This feature applies to 
the production process. During video production, you will be advised if and when you reach this low disk level 
threshold.

PREVIEW PANEL

Video production typically involves a high degree of overhead or video processing by the video card. Often a computer 
simply cannot keep up and is unable to display the video properly. For this reason, you may have to preview the video 
a bit at a time. Only by turning certain edits on and others off is the excessive processing reduced for preview 
purposes.

Preview Size

Select the size of frame to use to preview scenes in the Viewscreen. The 640 X 480 frame size option is only available 
if your screen resolution is set to 1280 X 1024.



Editor Preview

Use the slider provided to adjust the speed at which the frames of a single file are previewed in the Viewscreen while in
edit mode. For example, if you added text to a scene using the Title Animator, you can now adjust the speed at which 
you preview the effect upon clicking the Play button.

As the slider is moved towards REAL-TIME or streaming mode, frames are often omitted to compensate for the 
computer not being able to keep up. By doing so, you can get a feel for the motion when previewing the file.

If the slider is positioned at SHOW ALL FRAMES, you can view all the frames of a file albeit the motion may be 
“choppy” depending on system resources.

Storyline Preview

Select options for previewing multiple files and transitions of the Storyline in the Viewscreen. Use these options to 
control what you see in the Viewscreen.

Show Effects

Select this control to include any special effects you have added. Deselect the control to omit special effects from 
the preview.

Show Image Blending

Select this control to include any transparency effects created through the Text or Video Animators. Deselect the 
control to preview transparent text and images in solid, or opaque, format. Again, this may be necessary due to 
high overhead.

Show Text/Video Animations

Select this control to include text and video animations in the preview. Deselect the control to display background 
clips only.

Speed

Use the slider provided to adjust the speed at which the frames are previewed in the Viewscreen when multiple 
files and transitions are being shown.

As the slider is moved towards REAL-TIME, or streaming mode, frames are often omitted to compensate for the 
computer not being able to keep up. By doing so, you can get a feel for the motion when previewing the file.

If the slider is positioned at SHOW ALL FRAMES, you can view all the frames albeit the motion may be “choppy” 
depending on system resources.







Menu Commands - Start Menu

Click a command below to learn its use, or to view any options that may be available.

Storyline 

Edit 

Library 

Preferences 

Help Topic Search 

Technical Support 

Register MGI VideoWave

About MGI VideoWave 

Exit 



Topic Search

To locate information using the Table of Contents or the Index:

1. Click the Menu button at the top of the Toolbar.

2. On the Help menu, click TOPIC SEARCH. A Help window is displayed consisting of a Contents and an Index tab.

Shortcut

Keys F1

Note:

If you are already within the Help system, you can click the Help Topics button in any Help topic window to access the 
Table of Contents and Index.

Contents

   Opening a “Book”
Think of a “book” as a chapter in a real book; each chapter covers a major topic. In turn, each “book” is made up of several 
“pages” or sub-topics.

Open a book in one of two ways:

1. Double-click the “book” title or its associated icon.

2. Select the book, and click the Open button at the bottom of the dialog.

   Opening a “Page”
Think of a “page” as a sub-topic within the chapter of a book.

Open a page in one of two ways:

1. Double-click the “page” title or its associated icon.

2. Select the page, and click the Display button at the bottom of the dialog.

MGI VideoWave closes the Contents dialog and displays the help topic you selected. Within most topics, you will notice 
“green, underlined text” which when clicked displays related information. Green text with a solid underline denotes a “jump”
to another topic. Green text with a dashed underline denotes a simple “pop-up” of additional information.

After you read the information, you can click the Help Topics button in the Help window to return to the Table of Contents, or 
exit Help by clicking the Help window's Close control or by pressing the [Esc] key.

Index

Use Index to locate information by specifying a keyword or selecting one from a list as you would in an index of a book. 
Each keyword or keyphrase directs you to one or more Help topics.

Select a keyword (or keyphrase) in one of two ways:

1. Scroll through the list of keywords until the selection bar is on the correct word.

2. Type the keyword in the text field at the top of the Search dialog. As you type each character, the selection bar jumps 
to the first keyword using that character or sequence of characters.

Display the Help topic associated with the selected keyword in one of two ways:

1. Double-click the keyword in the list.

2. Click the Display button.

MGI VideoWave closes the Index dialog and displays the help topic you selected. Within most topics, you will notice “green, 
underlined text” which when clicked displays related information. Green text with a solid underline denotes a “jump” to 
another topic. Green text with a dashed underline denotes a simple “pop-up” of additional information. The original topic is 
not closed.

After you read the information, you can click the Help Topics button in the Help window to return to the Index, or exit Help by
clicking the Help window's Close control or by pressing the [Esc] key.







About MGI VideoWave

To recall the version number of the software:

1. Click the Menu button at the top of the Toolbar.

2. On the Help menu, click ABOUT MGI VIDEOWAVE. You can find the version number on the panel displayed.



Exit

To terminate the application:

1. Click the Menu button at the top of the Toolbar.

2. On the menu, click EXIT.

Shortcuts

· Exit control in the top right corner of your screen.

· ALT + F4 keyboard combination



Menu Commands - Storyline Menu

Right-click a video scene or transition in the Storyline to open the Storyline menu. If you right-click a video scene, the menu
shown below is displayed. If you right-click a filled or empty transition panel, some commands listed below are not available.
However, one unique command is ¾ Edit     Transition  .

Many commands have sub-menus of options associated with them. Click a command below to learn its use, or to view any 
options that may be available.

Edit / Preview 

Save Panel(s) 

Cut 

Copy 

Paste 

Remove 

Select All 

Goto 

Properties 



Menu Commands - Storyline Menu

Click a command below to learn its use, or to view any options that may be available.

Edit / Preview 

Save Panel(s) 

Cut 

Copy 

Paste 

Remove 

Select All 

Goto First Panel 

Last Panel 

Find Panel 

Properties 



Edit / Preview

To edit or preview a video scene, or a series of scenes:

1. Select the scene, or series of scenes, in the Storyline that you wish to preview, or the single scene that you wish to 
edit.

Note:

Only single scenes, or panels, can be edited ( the Mode selector tools appear available for selection). A selected series
of scenes, or panels, can only be previewed. In this case, the menu command displayed is PREVIEW, as opposed to 
EDIT / PREVIEW.

2. Right-click the video scene(s) to open the Storyline menu.

3. On the menu, click EDIT / PREVIEW (PREVIEW for a series of scenes). Your selection is displayed in the Viewscreen 
ready for preview, or for any editing that may be required.

See Also

How to transfer files to the Viewscreen 



Save Panel(s)

To save a Storyline panel(s) and add it to the Library:

1. Select a video panel, or series of panels, in the Storyline. 

Note:

Technically speaking, you are saving video scenes that reside in video panels.

Note:

A video file, or a series of files, is referred to as a scene once it is placed on the Storyline. Scenes include source video
files, edited video files, color panels, and a series of single scenes.

2. Right-click the panel, or series of panels, in the Storyline.

3. On the Storyline menu, click SAVE PANEL(S). The Save     As   file selector is displayed.

4. Assign a name and path to the file(s), and click Save to save it. The selection is saved and added to the currentlly 
active Library.

Note:

It is not necessary to type a file extension. Single video scenes are automatically assigned the extension .scn. A series
of scenes, including any transitions between them, is assigned the extension .sbd.The scene (or series of scenes) is 
added to the Library currently open on the screen.

See Also

How to select a series of scenes 







Cut

To cut a selected video clip or transition from the Storyline and store it on the Clipboard:

1. Right-click a video scene or transition in the Storyline.

2. On the Storyline menu, click CUT

Shortcuts

Toolbar

Keys CTRL + X

See Also

How to cut Storyline files and transitions to the Clipboard 



Copy

To copy a selected video clip or transition to the Clipboard:

1. Right-click a video scene or transition in the Storyline.

2. On the Storyline menu, click COPY

Shortcuts

Toolbar

Keys CTRL + C

See Also

How to copy Storyline files and transitions to the Clipboard 



Paste

To paste the contents of the Clipboard to a selected video or transition panel in the Storyline:

1. Right-click a video or transition panel in the Storyline. If you are pasting a video scene, right-click a video panel. If you 
are pasting a transition, right-click a transition panel.

2. On the Storyline menu, click PASTE.

Shortcuts

Toolbar

Keys CTRL + V

See Also

How to paste the contents of the Clipboard to the Storyline 



Remove

To remove a video scene or transition from the Storyline:

1. Right-click a video or transition panel in the Storyline.

2. On the Storyline menu, click REMOVE.

Shortcuts

Toolbar

Keys DELETE

See Also

How to delete items from the Storyline 



Select All

To select all scenes and transitions residing on the Storyline:

1. Right-click a video or transition panel in the Storyline.

2. On the Storyline menu, click SELECT ALL.

or

1. Click the Menu button at the top of the Toolbar.

2. On the Edit menu, click SELECT ALL.

or

1. Click the first video panel in the Storyline.

2. Press the SHIFT key.

3. Click the last panel in the Storyline.

Note:

With this technique, you need not select the entire Storyline. If you wish, you can select any series of scenes within the
Storyline.

Common uses of this command:

· To save the entire Storyline as an SBD file for use in other video productions. Simply execute this command, and then 
drag the Storyline to the Library. The Save As file selector will appear prompting you to assign a name to the file. Once 
you have done so, the file will be added to the Library.

· To cut or copy the entire Storyline to the Clipboard.

· To view the entire video composition in the Preview screen. Simply execute this command, and then drag the Storyline to 
the Viewscreen. Click the Play button to view the production.



First Panel

To advance to the first panel in the Storyline:

1. Right-click a video scene or transition in the Storyline.

2. On the Go To menu, click FIRST PANEL. The first panel is highlighted.

Shortcut

Keys HOME





Last Panel

To advance to the last panel in the Storyline:

1. Right-click a video scene or transition in the Storyline.

2. On the Go To menu, click LAST PANEL. The last panel is highlighted.

Shortcut

Keys END



Find Panel

To find a video panel on the Storyline:

1. Right-click a video scene or transition in the Storyline.

2. On the Go To menu, click FIND PANEL. The Find     Storyline     Panel   dialog is displayed.

Note:

Video panels are numbered and identified by their file name. Transition panels are indented and identified by their type.
Technically speaking, video scenes reside in panels on the Storyline. As a result, you are attempting to find a video 
scene as much as a video panel.

3. In the dialog, click the video panel or transition you wish to advance to.

4. Click the Go To button to advance to the selected video panel or transition.

Preview

A thumbnail of the selected video panel or transition is displayed in the top right-hand corner of the dialog.

Properties

Click this button to view the properties associated with the selected video panel. This button is available to video 
panels only. The Scene Properties dialog is displayed. For a description of this dialog, see Properties.



Properties

To examine the properties of a selected scene:

1. Right-click the scene in the Storyline.

2. On the menu displayed, click PROPERTIES. The Properties dialog is displayed. The dialog consists of two panels, 
File Properties and Edit Properties.

Note:

The fields in the Properties dialog are uneditable. Details are listed for information purposes only.

File Properties

Click the File Properties tab to display the panel.

File Details

Lists the scene’s general properties such as the scene’s name and duration, data rate, file size, and the date the scene
was produced.

Video Details

Lists the scene’s video properties such as frame size, frame rate, color depth, and the compressor used to create the 
scene.

Audio Details

Lists any audio file that may be associated with the scene.

Edit Properties

Click the Edit Properties tab to display the panel.

Time

Describes any marked In (start) and Out (end) points applied to the file, as well as the file’s duration. The Panel Start and 
Panel End values indicate where in the Storyline the file resides.

Effects

Indicates whether or not any special, text, or color effects have been applied to the file. The current status of the Scaling 
attribute, as set through the Preferences dialog, is also indicated.

Video animation effects can be added to a file through the Video Animator. If any effects have been added, the properties of 
the associated video file used to create the effect can be viewed here. Click the Properties button to view the information.

See Also

Video     Animator   

Text Animator 

Preferences dialog

Audio Tracks

The properties of any audio files associated with the video file can be viewed here. Click the Properties button to view the 
information.

See Also

How to get detailed information about a file 



Edit Transition

To edit or add a transition effect between two video scenes:

1. Right-click a transition panel in the Storyline.

2. On the menu displayed, click EDIT TRANSITION. The Transition Effects interface is opened below the Viewscreen.

Shortcut

Mode selector

See Also

Transition Effects 





Menu Commands - Library Menu

Right-click inside the Library to open the Library menu. If you prefer, click the small triangle in the top right corner of the 
Library to open the menu.

Where you click in the Library determines which commands are listed. In the list below, the commands have been grouped 
according to the panels, and the areas within the panels, in which they are made available. Click a command to learn its 
use.

All panels (all areas)

Add Files 

Video and Audio panels (source files only)

Cut 

Copy 

Paste 

Delete 

Rename 

Properties 

Video panel (video and still image files only)

Edit / Preview 

Insert into Storyline 

Audio panel (audio files only)

Play 

All panels (all areas other than source files)

New

Open 

Save 

Save As 

Show Thumbnails 



Add Files

To add source media files to the Library:

1. Right-click anywhere inside the Library, or if you prefer, click the small triangle in the top right corner of the Library.

2. On the Library menu displayed, click ADD FILES. The Open file selector is displayed. Use this selector to locate and 
select the desired files to be added to the Library. Source files include video, audio, and still image files. Video and still 
image files are added to the Video panel of the Library; audio files are added to the Audio panel of the Library.

Note:

Depending on where in the Library you right-click, the menu displayed may appear different than what you see here. In
each menu, however, this command is listed.







Cut

To cut a file from the Library and store it temporarily on the Clipboard:

1. Right-click the file in the Library.

2. On the Library menu displayed, click CUT.

Note:

You must right-click a video, image, or audio file in the Library to see this command. If you right-click an empty space, 
or any other library item, the menu displayed does not list this command.

Shortcuts

Toolbar

Keys CTRL + X

See Also

How to cut files from the Library to the Clipboard 



Copy

To copy a Library file to the Clipboard:

1. Right-click the file in the Library.

2. On the Library menu displayed, click COPY.

Note:

You must right-click a video, image, or audio file in the Library to see this command. If you right-click an empty space, 
or any other library item, the menu displayed does not list this command.

Shortcuts

Toolbar

Keys CTRL + C

See Also

How to copy Library files to the Clipboard 



Paste

To paste the contents of the Clipboard to the Library:

1. Right-click anywhere inside the Library. If you prefer, click the small triangle in the top right corner of the Library to open
the menu.

2. On the menu displayed,click PASTE. The contents of the Clipboard are pasted to the Library in the appropriate panel. 
Video and still image files are pasted to the Video panel; audio files are pasted to the Audio panel.

Shortcuts

Toolbar

Keys CTRL + V

See Also

How to paste the contents of the Clipboard to the Library 



Delete

To delete a file from the Library:

1. Right-click the file in the Library.

2. On the Library menu displayed, click DELETE.

Note:

You must right-click a video, image, or audio file in the Library to see this command. If you right-click an empty space, 
or any other library item, the menu displayed does not list this command.

Shortcuts

Toolbar

Keys DELETE

See Also

How to delete files from the Library 



Rename

To rename a file in the library:

1. Right-click the file in the Library.

2. On the Library menu displayed, click RENAME.

3. In the Save     As   file selector displayed, assign a new name and path (if you wish) to the file. The library file is renamed 
as well as any instances of it in the Storyline.

Note:

You must right-click a video, image, or audio file in the Library to see this command. If you right-click an empty space, 
or any other library item, the menu displayed does not list this command.

See Also

How to rename files 



Properties

To examine the properties of a selected file:

1. Right-click the file in the Library.

2. On the Library menu, click PROPERTIES. The Properties dialog is displayed. The dialog consists of two panels, File 
Properties and Edit Properties.

Note:

You must right-click a video, image, or audio file in the Library to see this command. If you right-click an empty space, 
or any other library item, the menu displayed does not list this command.

Note:

The fields in the Properties dialog are uneditable. Details are listed for information purposes only.

File Properties

Click the File Properties tab to display the panel.

File Details

Lists the scene’s general properties such as the scene’s name and duration, data rate, file size, and the date the scene
was produced.

Video Details

Lists the scene’s video properties such as frame size, frame rate, color depth, and the compressor used to create the 
scene.

Audio Details

Lists any audio file that may be associated with the scene.

Edit Properties

Click the Edit Properties tab to display the panel.

Time

Describes any marked In (start) and Out (end) points applied to the file, as well as the file’s duration. The Panel Start and 
Panel End values indicate where in the Storyline the file resides.

Effects

Indicates whether or not any special, text, or color effects have been applied to the file. The current status of the Scaling 
attribute, as set through the Preferences dialog, is also indicated.

Video animation effects can be added to a file through the Video Animator. If any effects have been added, the properties of 
the associated video file used to create the effect can be viewed here. Click the Properties button to view the information.

See Also

Video     Animator   

Text Animator 

Preferences dialog

Audio Tracks

The properties of any audio files associated with the video file can be viewed here. Click the Properties button to view the 
information.

See Also

How to get detailed information about a file 





Edit / Preview

To preview a Library video file in the Viewscreen:

1. Right-click the file in the Video panel of the Library.

2. On the Library menu, click EDIT / PREVIEW. The selected file is displayed in the Viewscreen ready for preview or any 
editing that may be required. If you wish to preview a video file, click the Play button on the Control panel.

Note:

Only video and still image files can be selected for edit / preview.

Shortcut

Drag and drop the video scene, or series of scenes, directly into the Viewscreen.

See Also

How to transfer files to the Viewscreen 



Insert into Storyline

To insert a Library file into the Storyline:

1. Right-click the file in the Video panel of the Library.

2. On the Library menu, click INSERT INTO STORYLINE. The file is inserted into the next available empty panel in the 
Storyline.

Note:

Only video and still image files can be inserted into the Storyline.

See Also

How to transfer files to the Storyline 



Play

To play (preview) an audio file in the Library:

1. Right-click the audio file in the Audio panel of the Library, 

2. On the Library menu, click PLAY. Use this option to play an audio file prior to attaching it to a video file.

Note:

Only audio files can be played.





New

To open a new Library file:

1. Right-click anywhere inside the Library other than a source file. In other words, right-click an empty space in the 
Library. The Library menu is displayed. If you prefer, click the small triangle in the top right corner of the Library to 
open the menu.

Note:

If you right-click an effect inside either the Text, Transition, or Special Effects panel (these panels are added to the 
Library for certain operations), this same Library menu is displayed.

Note:

Source files include video, audio, and still image files.

2. On the Library menu displayed, click NEW. A new Library file, consisting of blank Library panels, is opened. The 
previous Library file is closed.

Note:

Library files have the file extension, .vwl. Source media files (ie; AVI, MPG, BMP, WAV, etc.) are then added to and 
saved within the Library file for future reference.

See Also

How to load the files that will make-up the video 





Open

To open a previously saved Library file:

1. Right-click anywhere inside the Library other than a source file. In other words, right-click an empty space in the 
Library. The Library menu is displayed. If you prefer, click the small triangle in the top right corner of the Library to 
open the menu.

Note:

If you right-click an effect inside either the Text, Transition, or Special Effects panel (these panels are added to the 
Library for certain operations), this same Library menu is displayed.

Note:

Source files include video, audio, and still image files.

2. On the Library menu displayed, click OPEN. The Open file selector is displayed. Use this selector to locate and open 
the desired Library file.

Note:

Library files have the file extension, .vwl. Source media files (ie; AVI, MPG, BMP, WAV, etc.) are then added to and 
saved within the Library file for future reference.

See Also

How to load the files that will make-up the video 





Save

To save a previously named Library file:

1. Right-click anywhere inside the Library other than a source file. In other words, right-click an empty space in the 
Library. The Library menu is displayed. If you prefer, click the small triangle in the top right corner of the Library to 
open the menu.

Note:

If you right-click an effect inside either the Text, Transition, or Special Effects panel (these panels are added to the 
Library for certain operations), this same Library menu is displayed.

Note:

Source files include video, audio, and still image files.

2. On the Library menu displayed, click SAVE. All changes made to the Library file (ie; additions to and deletions from) 
since the time it was last saved are now saved permanently to the file.



Save As

To save a new Library file, or to save an existing one under a different name:

1. Right-click anywhere inside the Library other than a source file. In other words, right-click an empty space in the 
Library. The Library menu is displayed. If you prefer, click the small triangle in the top right corner of the Library to 
open the menu.

Note:

If you right-click an effect inside either the Text, Transition, or Special Effects panel (these panels are added to the 
Library for certain operations), this same Library menu is displayed.

Note:

Source files include video, audio, and still image files.

2. On the Library menu displayed, click SAVE AS. The Save     As   file selector is displayed. Use this selector to specify the 
name and path of the file. Library files have the file extension .vwl.





Show Thumbnails

To display Library files both by name and thumbnail:

1. Right-click anywhere inside the Library other than a source file. In other words, right-click an empty space in the 
Library. The Library menu is displayed. If you prefer, click the small triangle in the top right corner of the Library to 
open the menu.

Note:

If you right-click an effect inside either the Text, Transition, or Special Effects panel (these panels are added to the 
Library for certain operations), this same Library menu is displayed.

Note:

Source files include video, audio, and still image files.

2. On the Library menu displayed, click SHOW THUMBNAILS. Each file listed in the Library is displayed both by name 
and by thumbnail. A small, red indicator shows when this feature is active.

Note:

Click the menu command a second time to toggle this feature off and list the files by name only.



Menu Commands - Viewscreen Menu

Right-click inside the Viewscreen to open the Viewscreen menu. If you prefer, you can click the small triangle in the top 
right corner of the Viewscreen to open the menu. Following is a list of available menu commands. Click a command below 
to learn its use.

Clear 

Preferences 

Properties 







Clear

To clear the active video file from the Viewscreen:

1. Right-click anywhere inside the Viewscreen, or if you prefer, click the small triangle in the top right corner of the 
Viewscreen.

2. On the Viewscreen menu, click CLEAR. The video is removed from the Viewscreen.



Preferences

To specify your preferences, or options:

1. Right-click anywhere inside the Viewscreen, or if you prefer, click the small triangle in the top right corner of the 
Viewscreen.

2. On the Viewscreen menu, click PREFERENCES. The Preferences dialog is displayed consisting of two panels, the 
Preview panel and the General     Preferences   panel. It is within the Preview panel that preferences are specified 
governing the behavior of the Viewscreen.

PREVIEW PANEL

Video production typically involves a high degree of overhead or video processing by the video card. Often a computer 
simply cannot keep up and is unable to display the video properly. For this reason, you may have to preview the video 
a bit at a time. Only by turning certain edits on and others off is the excessive processing reduced for preview 
purposes.

Preview Size

Select the size of frame to use to preview scenes in the Viewscreen. The 640 X 480 frame size option is only available 
if your screen resolution is set to 1280 X 1024.

Editor Preview

Use the slider provided to adjust the speed at which the frames of a single file are previewed in the Viewscreen while in
edit mode. For example, if you added text to a scene using the Title Animator, you can now adjust the speed at which 
you preview the effect upon clicking the Play button.

As the slider is moved towards REAL-TIME, or streaming mode, frames are often omitted to compensate for the 
computer not being able to keep up. By doing so, you can get a feel for the motion when previewing the file.

If the slider is positioned at SHOW ALL FRAMES, you can view all the frames of a file albeit the motion may be 
“choppy” depending on system resources.

Storyline Preview

Select options for previewing multiple files and transitions of the Storyline in the Viewscreen. Use these options to 
control what you see in the Viewscreen.

Show Effects

Select this control to include any special effects you have added. Deselect the control to omit special effects from 
the preview.

Show Image Blending

Select this control to include any transparency effects created through the Text or Video Animators. Deselect the 
control to preview transparent text and images in solid, or opaque, format. Again, this may be necessary due to 
high overhead.

Show Text/Video Animations

Select this control to include text and video animations in the preview. Deselect the control to display background 
clips only.

Speed

Use the slider provided to adjust the speed at which the frames are previewed in the Viewscreen when multiple 
files and transitions are being shown.

As the slider is moved towards REAL-TIME, or streaming mode, frames are often omitted to compensate for the 
computer not being able to keep up. By doing so, you can get a feel for the motion when previewing the file.

If the slider is positioned at SHOW ALL FRAMES, you can view all the frames albeit the motion may be “choppy” 
depending on system resources.



GENERAL PREFERENCES PANEL

Display ToolTips

Select this control to display tooltips as the mouse is passed over icons.

Show Splash Screen on Startup

Select this control to view the MGI VideoWave product splash screen on loading the program.

Clear Library Contents on New Production

Select this control to clear all files from the Library when a new production, or storyline, is initiated.

Save Library with Production

Select this control to save the files within the Library when the video is produced. You will be prompted to assign a 
name and path to the library.

Open Last Production on Startup

Select this control to open on startup the last production, or storyline, worked on.

Default Clip Scaling Options

Scale to Frame

Select this option if you wish the scenes in your Storyline scaled to the frame size you choose in the Preview 
panel of this dialog.

Center in Frame

Select this option if you wish to center your scenes inside the frame.

Default Still Image Duration

A value specifying the number of seconds still images remain open on the screen.

Low Disk Level

Specify the threshold at which MGI VideoWave III advises you that you are low on disk space. This feature applies to 
the production process. During video production, you will be advised if and when you reach this low disk level 
threshold.





Properties

To examine the properties of the file:

1. Right-click anywhere inside the Viewscreen, or if you prefer, click the small triangle in the top right corner of the 
Viewscreen.

2. On the Viewscreen menu, click PROPERTIES. The Properties dialog is displayed. The dialog consists of two panels, 
File Properties and Edit Properties.

Note:

The fields in the Properties dialog are uneditable. Details are listed for information purposes only.

File Properties

Click the File Properties tab to display the panel.

File Details

Lists the scene’s general properties such as the scene’s name and duration, data rate, file size, and the date the scene
was produced.

Video Details

Lists the scene’s video properties such as frame size, frame rate, color depth, and the compressor used to create the 
scene.

Audio Details

Lists any audio file that may be associated with the scene.

Edit Properties

Click the Edit Properties tab to display the panel.

Time

Describes any marked In (start) and Out (end) points applied to the file, as well as the file’s duration. The Panel Start and 
Panel End values indicate where in the Storyline the file resides.

Effects

Indicates whether or not any special, text, or color effects have been applied to the file. The current status of the Scaling 
attribute, as set through the Preferences dialog, is also indicated.

Video animation effects can be added to a file through the Video Animator. If any effects have been added, the properties of 
the associated video file used to create the effect can be viewed here. Click the Properties button to view the information.

See Also

Video     Animator   

Text Animator 

Preferences dialog

Audio Tracks

The properties of any audio files associated with the video file can be viewed here. Click the Properties button to view the 
information.

See Also

How to get detailed information about a file 







Cutting Room      

Enter the Cutting Room to extract portions of a 
video, or to split a video in two.

To enter the Cutting Room:

1. Transfer to the Viewscreen the video file you 
wish to edit. The easiest way is to drag the 
file from the Storyline or the Library.

See
How to transfer files to the Viewscreen 

2. Click the Cutting Room button on the Mode 
selector. The Cutting Room console is added 
below the Viewscreen.

EXTRACT

To extract an image of a single frame (still image):

1. Use the Control panel to advance to the desired frame in the video scene.

Note:

First use the Time Slider to advance quickly to the general location of the frame. Then use the Previous     /     Next   
Frame buttons to advance to the precise location one frame at a time.

2. On the Cutting Room console, located below the Viewscreen, click the IMAGE button. The Extract     Images   dialog is 
displayed.

3. Click the BROWSE button to open the Save     As   file selector.

4. Assign a name and path to the image file to be extracted. Extracted images can be saved in JPG, BMP or TIF 
format.

Auto Rename

Select this control for continuous image extraction. File names are appended with incrementing numeric values. 
Example: Filename_001, Filename_002, and Filename_003.

Add to Storyline

Select this control to add the image to the Storyline upon extraction.

5. Click TO CLIPBOARD to copy the image to the Clipboard, or click EXTRACT to add the image to the Library.

Note:

To every still image is attached a time, or duration, attribute (expressed as a value). This value specifies the number 
of seconds a still image remains on the screen when it is part of a video production. By default, the setting is 5 
seconds. To specify a different value, see the TOOLBAR menu item, Still     Image     Duration  .

To extract a sound file currently attached to a video file:

1. On the Cutting Room console, located below the Viewscreen, click the AUDIO button . The Save     As   file selector is 
displayed.

2. Using the file selector, assign a name and path to the audio file to be extracted. Extracted sound files are saved in 
WAV format.



3. Click SAVE to extract and save the file. The file is added to the Audio panel of the active Library.

To extract a portion of a video file:

1. Use the Control panel to advance to the frame in the video that you wish the new clip to begin with.

Note:

First use the Time Slider to advance quickly to the general location of the frame. Then use the Previous     /     Next   
Frame buttons to advance to the precise location one frame at a time.

2. Click the Mark     In-Point   button.

3. Advance to the frame in the video that you wish the new clip to end with.

4. Click the Mark     Out-Point   button.

Note:

It is the portion of the video between the In-point and the Out-point that is saved; everything else is discarded. The 
file held in the Library (on your hard disk) is not altered. You will be prompted to save the file under a new file name.

In and Out-points can be removed or changed by simply resetting them. To cancel the Mark In and Out points 
entirely, click the Reset button.

Note:

The length of the extracted scene (the length in seconds between the In and Out-points) is displayed in the Duration 
value field.

5. On the Cutting Room console, located below the Viewscreen, click the VIDEO button. The Save     As   file selector is 
displayed.

6. Using the file selector, assign a name and path to the video file to be extracted. Extracted files are saved in AVI 
format.

7. Click SAVE to extract and save the file. The file is added to the Video panel of the active Library.

Note:

Trimming, or extracting, is especially useful for removing unwanted frames at the beginning and end of a captured 
file. One important benefit of keeping only files and portions of files you will need for the production is greatly reduced
disk space usage.

THUMBNAIL

Click this button to update the thumbnail on the Storyline to reflect the frame currently displayed in the Viewscreen. The 
thumbnails on the Storyline represent the scenes you are using to compose the finished video. Often, different portions of 
the same scene are used in the video (ie; a split scene). Rather than represent different portions of the same scene with 
the same thumbnail, use this option to differentiate the thumbnails on the Storyline.

Note:

It is the portion of the video between the In-point and Out-Point that is saved; everything else is discarded. The file held in 
the Library (on your hard disk) is not altered. You will be prompted to save the file under a new file name.

SPLIT

To split a scene in two:

1. Use the Control panel to advance to the frame in the video at which you wish to split the scene.

Note:

First use the Time Slider to advance quickly to the general location of the frame. Then use the Previous     /     Next   
Frame buttons to advance to the precise location one frame at a time.

2. On the Cutting Room console located below the Viewscreen, click the SPLIT button. Thumbnails representing the 
two portions of the split scene are displayed on the Storyline.



Note:

The length of the extracted scene (the length in seconds between the In and Out-points) is displayed in the Duration 
value field.

Note:

Often scenes are split in order to insert a transition between the two portions. For more information about transitions, 
see Transition     Effects   

Apply

Click this button to apply your settings to the file. The original file on your hard disk remains unchanged.

Close

Click this button to close the Cutting Room console . If you have not clicked the Apply button, any altered settings will be 
discarded. They will not be applied to the file.

























Darkroom      

 

Enter the Darkroom to adjust the brightness, 
contrast, and color of a video or still image. Use 
the controls to add tinting effects such as fade in, 
fade out, and color fades. Experimentation is 
encouraged, and until you produce the video, all 
changes to the file can be modified or removed.

To enter the Darkroom:

1. Transfer to the Viewscreen the video or 
image file that you wish to edit. The easiest 
way is to drag the file from the Storyline or 
the Library.

See
How to transfer files to the Viewscreen 

2. Click the Darkroom button on the Mode 
selector. The Darkroom console is added 
below the Viewscreen. The Filter panel is 
added to the Library.

Brightness, Contrast, and Color Adjustments

Use the three sliders labeled, Brightness, Contrast, and Color to apply fine adjustments to the brightness and overall hue of
a file. As the sliders are moved up or down, the video frame on the Viewscreen changes accordingly.

Red, Green and Blue

Use these three sliders to adjust the individual red, green and blue color values of the video file.

Filter

A number of predefined filters are included on the Filter panel in the Library. To apply the filter to the video file, simply drag 
the filter from the Library to the Viewscreen.

Apply

Click this button to apply your settings to the file. The original file on your hard disk remains unchanged.

Reset

Click this button to restore the default settings; all Darkroom settings applied to the original file are cancelled.

Undo



Click this button to undo those settings specified since the Darkroom console was last opened. Any changes made to the 
file in previous Darkroom sessions are maintained.

Close

Click this button to close the Darkroom console. If you have not clicked the Apply button, any altered settings will be 
discarded. They will not be applied to the file.









Special Effects      

 

Use the Special Effects editor to add special 
effects to a video file or to a still image.

To open the Special Effects editor:

1. Transfer to the Viewscreen the video or 
image file to which you wish to add special 
effects.

See
How to transfer files to the Viewscreen 

2. Click the Special Effects button on the Mode 
selector. The Special Effects console is 
added below the Viewscreen. A panel entitled
Effects is added to the Library. Included in 
this panel are a number of special effects 
from which to choose.

To add a special effect:

1. Drag a special effect from the Effects panel in the Library to the Special Effect box located below the Viewscreen. 
Alternatively, double-click the special effect in the Library.

2. Make sure that the START button located below the Viewscreen is highlighted.

3. Use the EFFECT LEVEL slider to set the level of effect as it begins. Your setting is displayed in the Viewscreen.

4. Option
If you wish, mark the point in the file at which the special effect is to start. This is done only if you wish the effect to 



begin at a point other than the very beginning of the file. Do so by moving the round, brown sphere on the Time     slider  
on the Control panel. You can also use the Next Frame / Previous Frame buttons above the slider to advance or 
backup the file frame by frame. Watch the Viewscreen as you do this to arrive at the desired frame. When you reach 
the desired frame, click the Mark     Start   button.

5. Click the HOLD button below the Viewscreen.

6. Use the EFFECT LEVEL slider to set the level of effect as it begins its hold position. Your setting is displayed in the 
Viewscreen.

7. Option
If you wish, mark the point in the video file where the effect is to start holding. Advance to the desired frame, and click 
the Begin     Hold   button below the Time slider.

Repeat this process to mark the end of the Hold position. Locate the frame at which the effect is to start moving again,
and click the End     Hold  . A thin red line on the Time slider indicates the extent of the hold position.

Note:

If you do not set a Hold time interval, or duration, a default setting of one second is applied.

8. Click the FINISH button below the Viewscreen.

9. Use the EFFECT LEVEL slider to set the level of effect as it ends. Your setting is displayed in the Viewscreen.

10. Option
If you wish, mark the point in the file at which the special effect is to end. This is done only if you wish the effect to end 
at a point other than the very end of the file. Advance to the desired frame, and click the Mark     Finish   button. A thin 
white line on the Time slider extends between the Mark Start and Mark Finish points, interrupted only by the extent of 
the Hold position (thin red line). The white line illustrates the portion of the file to which the special effect has been 
applied.

11. Click the PLAY button on the Control panel to see the effect of your settings.

Note:

To make sure you are starting at the beginning of the file, click the FIRST FRAME button on the Control panel before 
clicking the PLAY button.

12. When you are satisfied with the settings, click the APPLY button to apply the settings to the video file.

Black/Red Indicators

A small indicator is located beside the Special Effects button. If the indicator is colored black, it indicates that no settings 
have been altered in this mode. If the indicator is colored red, it indicates that you have altered and applied settings in this 
mode. Consider red indicators as reminders of what edits have been made to the original file. This feature is useful if you 
wish to undo these settings in the future.

Apply

Click this button to apply your settings to the file. The original file on your hard disk remains unchanged.

Reset

Click this button to restore the default settings; all special effects applied to the original file are cancelled.

Undo

Click this button to undo those settings specified since the Special Effects console was last opened. Any changes made to 
the file in previous Special Effects sessions are maintained.

Close

Click this button to close the Special Effects console. If you have not clicked the Apply button, any altered settings will be 
discarded. They will not be applied to the file.

Applying special effects to still images

You can apply any of the Special Effects listed above to still images the same way you would apply them to video files.











Example

{mci NOMENU,SPEFFECT.AVI}

Click the Play button, or drag the scrollbar, to play the example.

To create this effect:

1. Transfer the demo clip, CLOCK.AVI, to the Viewscreen.

2. Click the SPECIAL EFFECTS button on the Mode selector. The Special Effects console is opened below the 
Viewscreen.

3. Drag the SWIRL effect from the Effects panel in the Library to the Effects box on the Special Effects console.

4. Click the START button.

5. Use the EFFECT LEVEL slider to set a Start value around 0 so that the file begins with a “normal-looking” clock.

6. Click the FINISH button.

7. Use the EFFECT LEVEL slider to set a Finish value around 50. A positive value specifies a clockwise rotation; a 
negative value would specify a counter-clockwise direction of swirl.







Text Animator      

 

Use the Text     Animator   to add text to your video 
files.

To open the Text Animator:

1. Transfer to the Viewscreen the video file you 
wish to add text to.

See
How to transfer files to the Viewscreen 

2. Click the Text Animator button on the Mode 
selector. The Text Animator console is added 
below the Viewscreen. Two panels are added
to the Library, the Effects panel and the 
Paths panel.

First, specify the general text attributes:

1. Click the mouse inside the text editor window, and type the desired text. Each line of text is separated from the next 
by pressing the [Enter] key. As you type, the text is displayed in the Viewscreen.

2. Click the FONT button to open the Font dialog. Use this dialog to select a font, font style, font size, and justification 
value for the text.

3. Specify whether or not an OUTLINE or SHADOW / GLOW is to be added to the text face by clicking the appropriate 
controls. Deselect the FACE control to cancel any color in the text face - only the outline and/or shadow/glow of the 
text will be visible. At least one control must be selected. The settings you specify here apply to the entire text no 
matter what position it is at, whether that be the Start, Hold, or Finish of the video.



Second, specify how the text enters the screen:

1. Click the START button below the Viewscreen to specify how the text will enter the screen.

2. Option

If you wish, select a predefined text effect by dragging it from the Effects panel of the Library to the Viewscreen. 

Experimentation is encouraged. Note that you are not restricted to the colors and color transparencies of the 
predefined effects. These can be modified through the Text     Effects   panel. This is discussed in further detail below.

3. Option

Click the TEXT EFFECTS button. The Text     Effects   panel is displayed. Controls are provided in this dialog to adjust 
the color and transparency of the text face, outline, and shadow/glow. Make the necessary adjustments, and close 
the dialog.

Note:

In order for the controls of a particular section of the dialog, or text attribute (Face, Outline, and Shadow / Glow), to 
be active, their associated control on the Text Animator console (Face, Outline, and Shadow) must be selected.

COLOR BUTTONS

Color buttons are provided for each text attribute. Click a button to open the Color     Dialog  . Use the dialog to specify 
colors for the text face, outline, and shadow/glow. For a description of the Color Dialog, see Using     the     Color     Dialog  .

TRANSPARENCY SLIDERS

Use the sliders provided to adjust the transparency of the text attributes. Transparency refers to the extent to which 
the background image shows through the attribute.

OUTLINE THICKNESS

You can adjust the thickness of the text outline using the appropriate controls, THIN, MED, and FAT.

OTHER SHADOW / GLOW SLIDERS

Use the DEPTH slider to specify a depth of shadow. Depth refers to the offset distance between the text and its 
shadow.

Use the SOFTEN slider to soften the appearance of text shadows. Settings range from 0 to 20% of the text size.

Use the SHADOW ANGLE slider to set the angle at which the shadow is offset from the text.

4. If you have multiple lines of text, specify how they are to enter the screen. Select the control MOVE LINES 
TOGETHER to enter the text as one block. Otherwise, multiple lines of text are entered one line at a time.

5. From the PATHS panel in the Library, choose the direction from which the text is to flow onto the screen. To specify 
the path, simply drag it from the Library to the Viewscreen, or double-click it. Your selection is reflected in the 
Viewscreen as well as the small positioning grid below the Viewscreen.

or

Click the appropriate sector (square) in the Position grid to specify the direction. The grid represents your video clip 
divided into nine sectors.

Note:

Each sector in the grid describes a direction. If you select the top left square as the Start direction, your text will 
move onto the screen from the top left corner. If you select the center square, the text will simply appear in the center
of the screen.

6. Option

If you wish, mark the point in the video file where the text is to start entering the screen. This is done only if you wish 
the effect to begin at a point other than the very beginning of the file. Do so by moving the round, brown sphere on 
the Time     slider   on the Control panel. You can also use the Next Frame / Previous Frame buttons in the panel to 
advance or backup the file frame by frame. Watch the Viewscreen as you do this to advance to the desired frame. 
When you have reached the frame, click the Mark     Start   button.

Third, specify how the text pauses on the screen:

1. Click the HOLD button below the Viewscreen to specify how the text will pause on the screen.



2. Adjust the color and transparency of the text, as well as its pause position. Follow the same procedure as described 
above.

3. Option
If you wish, mark the point in the video file where the text is to start holding. Do so by moving the round, brown 
sphere on the Time     slider   on the Control panel. You can also use the Next Frame / Previous Frame buttons in the 
panel to advance or backup the file frame by frame. Watch the Viewscreen as you do this to advance to the desired 
frame. When you have reached the frame, click the Begin     Hold   button.

Repeat this process to mark the end of the Hold position. Locate the frame at which the text is to start moving again, 
and click the End     Hold  .

Note:

If you do not set a Hold time interval, or duration, a default setting of one second is applied.

Finally, specify how the text leaves the screen:

1. Click the FINISH button below the Viewscreen to specify how the text will leave the screen.

2. Adjust the color and transparency of the text, as well as its directional flow when leaving the screen. Follow the same
procedure as described above.

3. If you have multiple lines of text, specify how they are to leave the screen. Select the control MOVE LINES 
TOGETHER to exit the text as one block. Otherwise, the text will exit one line at a time.

4. Option
If you wish, mark the point in the video file where the text is to start leaving the screen. This is done only if you wish 
the effect to end at a point other than the very end of the file. Do so by moving the round, brown sphere on the 
Time     slider   on the Control panel. You can also use the Next Frame / Previous Frame buttons in the panel to 
advance or backup the file frame by frame. Watch the Viewscreen as you do this to advance to the desired frame. 
When you have reached the frame, click the Mark     Finish   button.

Viewing the effect:

1. Click the PLAY button on the Control panel to see the effect of your settings.

Note:

To make sure you are starting at the beginning, click the FIRST FRAME button in the same Control panel before 
clicking the Play button.

2. When you are satisfied with your settings, click the APPLY button to apply the Text Animation settings to your file.

Apply

Click this button to apply your settings to the file. The original file on your hard disk remains unchanged.

Reset

Click this button to restore the default settings; all effects applied to the original file are cancelled.

Undo

Click this button to undo those settings specified since the Text Animator was last opened. Any changes made to the file in 
previous Text Animator sessions are maintained.

Close

Click this button to close the Text Animator. If you have not clicked the Apply button, any altered settings will be discarded. 
They will not be applied to the file.



Color Dialog      

This dialog is opened by clicking any Color button that is made available in the program. Color buttons are provided in both
the Text and Video Animators.

Basic Colors

Eight basic colors are displayed. Color swatches cannot be added to or removed from this group. To select a basic color, 
simply click its swatch.

Custom Colors

Up to 24 custom colors can be added to this color table. Select the color to be added using any of the techniques described
below. To add the color to the table, click the ADD TO CUSTOM button. The color is added to the next available swatch in 
the table. You can also replace one color with another in this table. Simply, click the color swatch to be replaced before 
clicking the ADD TO CUSTOM button.

Selecting colors

1. Click a basic or custom color swatch in their respective tables.

or

1. Specify an overall color group using the vertical, color strip.

2. Fine-tune color selection within the group by clicking the desired color inside the large color square to the right of the 
strip. You can also drag the crosshair within the square to identify the color.

or

1. Specify H-S-V or R-G-B values directly in their respective value fields.

or

1. Click the PICK A COLOR button. Click the desired color in the Viewscreen. Your selection is reflected in the vertical 
color strip and the large color square.

Old | New

The original color selection (before you opened the dialog) is displayed beside your new selection for comparison 
purposes.



























Example

{mci NOMENU,TEXT2.AVI}

Click the Play button, or drag the scrollbar, to play the example.

To create this effect:

1. The source demo clip, CLOUDS.AVI, was first trimmed to 3.4 seconds in the Cutting Room and produced as a 
separate AVI file.
See
Cutting Room 
How to save and produce a video 

2. Transfer the shortened CLOUDS scene to the Viewscreen.

3. Click the Text Animator button on the Mode selector. The Text Animator console is opened below the Viewscreen.

4. In the small Text Editor, type the text as three separate lines, each line separated by pressing the [Enter] key.

ie;
Text moving [Enter]
on and off [Enter]
the screen

5. Click the FONT button, and set the font and size of text in the Font dialog (ie; Times Roman, Bold, 18 pt.). In this 
example, text justification was set to CENTER.

6. Click the START button below the Viewscreen.

7. Click the top, left square in the Position grid to specify the direction from which the text is to enter the screen.

8. Deselect the control, MOVE LINES TOGETHER, so that the text enters the screen one line at a time.

9. Click the FINISH button.

10. Click the bottom right square in the Position grid.

11. Make sure that the control, MOVE LINES TOGETHER, is still deselected.



Transition Effects      

 

Use the Transition Editor to add transitions 
between video files in your Storyline.

To open the Transition Editor:

1. In the Storyline, click the transition panel you 
wish to edit.

2. Click the Transition Effects button on the 
Mode selector. The Transition Editor console 
is added below the Viewscreen. The Trans 
panel, consisting of a number of transition 
effects, is added to the Library.
or
Double-click the transition panel in the 
Storyline to open the Editor.
or
Right-click a transition panel in the Storyline, 
and select EDIT TRANSITION from the menu
displayed to open the Editor.

Note:

The Trans panel includes a number of transition effects from which to choose. Experimentation is encouraged.

Description:

Transitions are cinematic effects that indicate and reinforce the flow from one idea to another. They are used between 
video clips to provide a means of introducing or changing clips. Transitions can be as simple as a cut (where there is simply
an instantaneous change to a new clip) to complex fades or blends designed to invoke a specific mood.



Use transitions to:

• Guide your audience’s attention to specific screen areas.

• Maintain coherence when moving between contexts.

• Alert audiences to new objects and changes to your video presentation.

• Reinforce the action.

To add a transition effect:

1. On the Storyline, click the transition panel you wish to edit. The video scenes preceding and succeeding the 
transition panel are displayed below the Viewscreen.

2. Select a transition effect from the Trans panel in the Library, and drag it to the small Transition box located below the 
Viewscreen, between the preceding and succeeding video scenes.

3. Set the duration of the transition. If, for example, you set a duration of 1.0, then one second will be contributed by 
each of the preceding and succeeding scenes towards the transition. You can also drag the small FILMSTRIP to set 
duration values. The two film strips represent the length of each video scene relative to each other. The film overlap 
represents the duration of the transition.

Note:

You cannot modify the duration of the video scenes directly. Their values are displayed for information purposes only.

4. To preview your setting, hold the SHIFT key, and select the preceeding scene, the transition, and the succeeding 
scene in the Storyline. Each will be highlighted when selected. Click the PLAY button on the Control panel.

Note:

To make sure you are starting at the beginning, click the FIRST FRAME button on the same Control panel before 
clicking the PLAY button.

5. When you are satisfied with your settings, click APPLY.

Apply

Click this button to apply your settings. The original file on your hard disk remains unchanged.

Reset

Click this button to restore the default settings; all effects applied to the original file are cancelled.

Undo

Click this button to undo those settings specified since the Transition Editor was last opened. Any changes made to the file 
in previous Transition Editor sessions are maintained.

Close

Click this button to close the Transition Editor. If you have not clicked the Apply button, any altered settings will be 
discarded. They will not be applied to the file.



Example

{mci NOMENU,TRANEFFECT.AVI}

Click the Play button, or drag the scrollbar, to play the example.

To create this effect:

1. The source demo file, CLOUDS.AVI, was first trimmed to 3.4 seconds in the Cutting Room, and then produced as a 
separate AVI file.
See
Cutting Room 
How to save and produce a video 

2. Transfer the shortened CLOUDS scene to the Storyline.
3. Transfer the demo file, CLOCK.AVI, to the next panel in the Storyline.
4. Select the transition panel between the two video files, and click the Transition Effects button.
5. Drag the effect, CORNER WIPE FROM TOP-LEFT, from the Trans panel in the Library to the small box between the 

two video thumbnails on the Transition Effects console.
6. Set the transition duration to 2.0 seconds.







Video Animator      

 

Use the Video Animator to blend or fade one video
file over another.

To open the Video Animator:

1. Select a video scene on the Storyline. This will
be your background scene.

2. Click the Video Animator button on the Mode 
selector. The Video Animator console is added
below the Viewscreen. The Motion panel, 
consisting of a number of motion paths, is 
added to the Library.

Description

A video file can be overlayed onto another from one of eight directions, or from the center. You can set the transparency of 
the file, 

the length of time it remains overlayed, and the direction it moves off the screen. With the Video Animator, you specify one 
file as the background and another as the foreground. The foreground file will overlay the background one.

Note:

You can specify whether or not any sound files currently attached to your video files will play during the effect. For more 
information, see Audio Studio.



To create the effect:

1. Double-click a video scene in the Storyline. The scene is displayed in the Viewscreen. Alternatively, drag the scene 
from the Storyline to the Viewscreen.

2. Click the Video Animator button on the Mode selector. The Video Animator console is opened below the Viewscreen. 
The video file selected in Step 1 is designated the Background file, and is represented in the small Background 
window.

3. Select a foreground file by double-clicking it in the Library. The file is represented in the small Foreground window 
beside the Background one. Alternatively, drag the file from the Library to the Foreground window to specify the 
Foreground file.

4. Decide whether you wish to blend the two files as the effect, or remove a measure of color from the foreground file as
it moves through the background one.

Blend Image

Select this control to blend the two files as the effect. In later steps, you will use the TRANSPARENCY slider 
displayed to adjust how much of the background will show through the foreground file at the Start, Hold and Finish 
positions.

or

Remove Color

Select this control to remove a measure of color from the foreground file as it moves through the background one. 
Click the COLOR button, and choose the color you wish to remove from the Color Dialog displayed. In later steps, 
you will use the TOLERANCE slider to set the amount of that color to remove at the Start, Hold and Finish positions. 
To learn how to use the Color Dialog, see Using     the     Color     Dialog  .

5. Click the START button below the Viewscreen.

6. Use the SIZE slider to set the size of the foreground file as it moves onto the screen.

7. If you chose to blend the two video files in Step 4, use the TRANSPARENCY slider to adjust how much of the 
background will show through the foreground file at this position.

If you chose to remove color from the foreground file as the effect, use the TOLERANCE slider to specify the amount
of color to be removed at this position.

8. In the Position grid, set the direction from which the foreground file will move onto the screen. The grid represents 
your video clip divided into nine sections. You can choose one of the preset, default sequences from the Motion 
panel in the Library if you prefer.

Note:

Each section in the grid describes a direction. If you select the top left square as the START direction, your 
foreground file will move onto the screen from the top left corner. If you select the center square, the file will simply 
appear in the center of the screen.

9. Option
If you wish, mark the point in the background file where the foreground one is to start entering the screen. This is 
done only if you wish the effect to begin at a point other than the very beginning of the file. Do so by moving the 
round, brown sphere on the Time     slider   on the Control panel. You can also use the Next Frame / Previous Frame 
buttons in the panel to advance or backup the file frame by frame. Watch the Viewscreen as you do this to arrive at 
the desired frame. When you have reached the frame, click the Mark     Start   button.

10. Click the HOLD button below the Viewscreen.

11. Adjust the size of file, transparency/tolerance, and file location at the Hold position. Use the same procedures as 
described above.

12. Option
If you wish, mark the point in the video file where the foreground file is to start holding. Do so by moving the round, 
brown sphere on the Time     slider   on the Control panel. You can also use the Next Frame / Previous Frame buttons in
the panel to advance or backup the file frame by frame. Watch the Viewscreen as you do this to advance to the 
desired frame. When you have reached the frame, click the Begin     Hold   button.

Repeat this process to mark the end of the Hold position. Locate the frame at which the foreground file is to start 
moving again, and click the End     Hold  .

13. Click the FINISH button below the Viewscreen.

14. Adjust the size of file, transparency/tolerance, and directional flow as the file moves off the screen. Use the same 
procedures as described above.

15. Option



If you wish, mark the point in the video file where the foreground file is to start leaving the screen. This is done only if 
you wish the effect to end at a point other than the very end of the file. Do so by moving the round, brown sphere on 
the Time     slider   on the Control panel. You can also use the Next Frame / Previous Frame buttons in the panel to 
advance or backup the file frame by frame. Watch the Viewscreen as you do this to advance to the desired frame. 
When you have reached the frame, click the Mark     Finish   button.

16. To preview your video animation, click the PLAY button on the Control panel.

Note:

To make sure you are starting at the beginning, click the FIRST FRAME button on the same Control panel before 
clicking the PLAY button.

17. When you are satisfied with your settings, click APPLY to apply the Video Animator settings.

Trimming the Foreground file using the Scene Trimmer

Use the Scene Trimmer to trim away any unwanted portions of a foreground video file.

To open the dialog:

1. Double-click inside the Foreground window.

To trim a video file:

1. Move the small, brown sphere on the Time Slider to the point in the file where you want to begin. Any portion of the 
file before this point is discarded.

2. Click the Mark In button.

3. Move the small, brown sphere on the Time Slider to the point in the file where you want to end. Any portion of the file 
after this point is discarded.

4. Click the Mark Out. The white line beneath the slider indicates the portion of the file to be saved.

5. Use the other buttons in the dialog to advance or step back to different positions in the file. PLAY and PAUSE buttons
are provided for you to review your settings.

Returns to the beginning of the file.

Advances to the In position.

Advances to the Out position.

Advances to the end of the file.

Apply

Click this button to apply your settings to the file. The original file on your hard disk remains unchanged.

Reset

Click this button to restore the default settings; all effects applied to the original file are cancelled.

Undo

Click this button to undo those settings specified since the Video Animator was last opened. Any changes made to the file 
in previous Video Animator sessions are maintained.

Close

Click this button to close the Video Animator. If you have not clicked the Apply button, any altered settings will be 
discarded. They will not be applied to the file.





Example

{mci NOMENU,VIDANIM.AVI}

Click the Play button, or drag the scrollbar, to play the example.

To create this effect:

1. The source demo clip, CLOUDS.AVI, was first trimmed to 3.4 seconds in the Cutting Room, and then produced as a 
separate AVI file.
See
Cutting Room 
How to save and produce a video 

2. Transfer the shortened CLOUDS scene to the Storyline.

3. Make sure that the same shortened CLOUDS scene in the Storyline is highlighted. This will be the background file.

4. Click the Video Animator button on the Mode selector.

5. Double-click the CLOCK.AVI demo clip in the Library. This will be the foreground file.

6. Select the control IMAGE BLEND.

7. Click the START button. Using the sliders provided, set the SIZE to 0% and the TRANSPARENCY to 100.

8. Click the HOLD button. Set the SIZE to 50% and the TRANSPARENCY to 50.

9. Reduce the Hold time duration to 0 by setting the START HOLD and FINISH HOLD points at the same location on 
the Time slider (halfway).

10. Click the FINISH button. Set the Size to 100% and the TRANSPARENCY to 0.









Audio Studio      

Use the Audio Studio to add sound to your video 
files.

To open the Audio Studio:

1. Transfer to the Viewscreen the video file you 
wish to add sound to.

See
How to transfer files to the Viewscreen 

2. Click the Audio Studio button on the Mode 
selector. The Audio Studio console is added 
below the Viewscreen. The Audio panel, 
where sound files are grouped, is added to the
Library.

Note:
Up to six audio tracks can be assigned to a 
video file.

To add sound to a video file:

1.    Add a sound file(s) to the Library.

1. Rightclick inside the Library, and select ADD FILES from the menu displayed. The Open file selector is displayed.

Note:

If you right-click inside the Audio panel of the Library and select ADD FILES, the file selector displayed will default to 
Sound Files (.wav).

If you right-click inside the Video panel of the Library and select ADD FILES, the file selector displayed will default to 
All Media Files.

2. Browse your hard disk or CD-ROM, and select the audio file(s) you wish to add. The audio file(s) you select is added 
to the Audio panel of the Library.

2.    Listen to the sound file(s).

1. If you wish to listen to a sound file listed in the Library, right-click its file name in the Library, and select PLAY from 
the menu displayed.

Note:

The Audio Studio must be closed if you plan to listen to sound files in this way.



2. If you wish to stop playing the file, right-click the file name again, and select STOP from the menu displayed.

or

1. Preview the sound from within the Audio Studio (this is described later in this procedure).

3.    Load the desired sound file(s) into the Audio Studio.

1. Drag a video file from the Library or the Storyline to the Viewscreen. This is the file to which the sound is to be 
added.

2. Click the Audio Studio button on the Mode selector. The Audio Studio console is opened below the Viewscreen. Any 
audio tracks currently associated with the video file are identified.

3. Drag the desired sound file(s) from the Library to the Audio Track window.

Note:

To preview a sound file listed in the Audio Track window, select the file and click the PLAY button on the Control 
panel. Click the STOP button on the same console to stop playing the file.

If you want the video and sound files played together, select the control, ENABLE VIDEO PREVIEW. To listen to the 
sound alone, deselect the control.

4.    Establish the duration of the sound file(s).

1. Select a sound file in the Audio Track window, and click the CLIP button. The Audio     Trimmer   dialog is displayed.

Note:

The CLIP button is available only to independent sound files, not to sound files currently associated with the video 
file.

2. In the Audio Trimmer, mark the desired In and Out points for the sound file. These points define the portion of the 
sound file to keep; the unwanted portions are trimmed away. For a complete description of the Audio Trimmer, see 
Audio     Trimmer  .

5.    Specify when the sound file(s) begin to play relative to the video.

1. Select a sound file in the Audio Track window.

2. Mark the point in the video file where the sound is to start. This is done only if you wish the sound to begin at a point 
other than the very beginning of the file. Do so by moving the round, brown sphere on the Time     Slider   on the Control
panel. Click the Mark     Start   button.

6.    Specify other characteristics for the sound file(s).

1. Use the VOLUME slider to set the volume level of an audio track. Each track can have a different volume level.

2. Select the FADE IN control to smoothly increase the volume of an audio track from zero to full volume as the video 
begins to play.

3. Select the FADE OUT control to smoothly decrease the volume of an audio track to zero as the end of the video 
approaches.

4. Click REPEAT if an audio track is too short for your video file. The audio track will be repeated as many times as 
necessary to match the duration of the video.

5. Use the MIX controls to specify which audio tracks to play with the video file when previewing. This allows you to 
check and adjust the volume and in/out points of each audio track individually, or as a group.

6. Click Apply to have the audio tracks and volume effects added to your file.



Enable Video Preview

Select this control to play the video and sound files together when the Play button is clicked on the Control panel. Deselect 
the control to play the sound file only.

Apply

Click this button to apply your settings to the file. The original file on your hard disk remains unchanged.

Reset

Click this button to restore the default settings; all effects applied to the original file are cancelled.

Undo

Click this button to undo those settings specified since the Audio Studio was last opened. Any changes made to the file in 
previous Audio Studio sessions are maintained.

Close

Click this button to close the Audio Studio. If you have not clicked the Apply button, any altered settings will be discarded. 
They will not be applied to the file.

























Audio Trimmer      

Use the Audio Trimmer to trim away any unwanted portions of a sound file.

To open the dialog:

1. Click the Audio Studio button on the Mode selector. The Audio Studio console is opened below the Viewscreen.

2. Select the sound file you wish to trim in the Audio Track window, and click the CLIP button.

Note:

The CLIP button is available only to independent sound files, not to sound files currently associated with the video 
file.

To trim a sound file:

1. Move the small, brown sphere on the Time Slider to the point in the sound file where you want to begin. Any portion 
of the file before this point is discarded.

2. Click the Mark In button.

3. Move the small, brown sphere on the Time Slider to the point in the sound file where you want to end. Any portion of 
the file after this point is discarded.

4. Click the Mark Out. The white line beneath the slider indicates the portion of the file to be saved.

5. Use the other buttons in the dialog to advance or step back to different positions in the sound file. PLAY and PAUSE 
buttons are provided for you to review your settings.

Returns to the beginning of the file.



Advances to the In position.

Advances to the Out position.

Advances to the end of the file.



Output to Video      

Use the Output to Video console to play a video 
file full-screen on a monitor or to output the file to 
tape.

To open the Output to Video console:

1. Transfer to the Viewscreen the video file you 
wish to output.

See
How to transfer files to the Viewscreen 

2. Click the Output to Video button on the Mode 
selector. The Output to Video console is added
below the Viewscreen.

Output to Video and Capture are separate video modes, performing an opposite (though similar) function. Output to Video 
sends the video to an outside source (such as your monitor screen or a connected VCR), while Capture brings video in from
an outside source (such as a camcorder, TV, CD or DVD player). The specific features of each mode will depend on the 
capabilities of your capture board.

Digital Video (DV) utilizes the IEEE 1394 connection and presents its own unique set of features to Output to Video and 
Capture.

To output a scene to full Screen on a monitor:

1. On the Storyline, select the scene you wish to output to video.

2. Click the Output to Video button on the Mode selector. The scene is transferred to the Viewscreen and the Output to 
Video console is opened below the Viewscreen.

3. On the Output to Video console, select FULL SCREEN from the Output list.

4. Click the BEGIN button to start video output. The video will be displayed full screen on your monitor.

5. To end the video output before the scene has run its course, right-click the mouse or press the ESC key on the 
keyboard to return to the Viewscreen.

To output a scene to an outside source (VCR):

The Output list may contain additional options, depending on your capture hardware and the codec used to compress the 
video file. Examples of these are M-JPEG (Motion JPEG) and DVSoft (Digital Video).

Some manufacturers market M-JPEG capture boards that can save .AVI files using the M-JPEG codec. Some of these 
boards can output the video to a connected device (such as a VCR). If you have such a board and have created an .AVI 
using the M-JPEG codec, you will be able to output these files to tape.



1. Load the .AVI file (produced with the M-JPEG codec) into the Library.

2. Drag the .AVI file from the Library to the Viewscreen.

3. Click the Output to Video button on the Mode selector. The Output to Video console is displayed below the 
Viewscreen.

4. Select M-JPEG from the Output list.

5. Click the BEGIN button to start video output. The video will be output through your capture hardware to the connected
device (VCR).

6. To end the video output before the scene has run its course, right-click the mouse or press any key on the keyboard 
(except the SPACEBAR) to return to the Viewscreen.

Pause on First Frame

Select this control to display the first frame of the video, paused on your monitor, when the BEGIN button is clicked. Pausing
on the first frame allows you time to set the record button on your VCR, for example. Press the SPACEBAR on the 
keyboard, or click the mouse, to start video playback and send the scene through the capture hardware to the VCR.

Pause on Last Frame

Select this control to play video back on your monitor and pause on the last frame. Use this option to avoid an abrupt ending
to the playback if you are recording to a VCR. Press the SPACEBAR on the keyboard, or click the mouse, to end the pause 
and return to the Viewscreen.

Output to Video using DV (Digital Video)

With MGI VideoWave IIII you can control digital devices connected to the IEEE 1394 (FireWire) port. If such a device (a DV 
camcorder, for example) has been connected to your computer, entering Output to Video mode will present the DV controls 
on the Control panel.

Select the DV device from the Output list to display the DV controls.

The DV controls are similar to the regular edit controls, with a few exceptions. There is no LOOP button, since this function 
is not applicable. The FIRST FRAME and LAST FRAME buttons have been replaced by REWIND and FAST FORWARD, 
respectively.

Use the DV controls to control the DV camera connected to your computer. Click the PLAY button to play the videotape. The
playback will be shown on the Viewscreen.

Jog Shuttle control

This control makes it easy to find the section of tape you wish to reach. While the tape is playing or paused, drag the cursor 
to the right or left to cue or review the tape, respectively. The Viewscreen displays the playback at a higher speed than 
normal. The further you drag the cursor, the faster the tape is reviewed.

Note:

In order to see the tape playback on the Viewscreen when the Fast Forward, Rewind or Jog Shuttle controls are used, the 
tape must be playing or paused. If the tape is stopped, using the controls will rewind or advance the tape without the tape 
contents being shown on the Viewscreen





Capture Editor      

Use the Capture Editor to transform analog video 
into digitized AVI files (Video for Windows) that can 
be added later to a video production. The resolution
and frame rate of the AVI file are determined by the 
capabilities of the capture hardware. .A capture 
card must be installed on your system.

With the capture card, you can capture video or still
images from a video camera, television, VCR, or 
laserdisc player. Used with a sound card, the 
capture software provides CD-quality sound with 
sampling rates of up to 44kHz. Depending on your 
audio hardware, audio can be captured at 11kHz, 
22kHz, or 44kHz, in 8-bit or 16-bit mono or stereo.

To open the Capture Editor:

1. Click the Capture button on the Mode selector.
The Capture Editor console is added below the
Viewscreen.

For more information, see:

Capturing analog video 

Capturing still images 

Capturing a sequence of frames 

Capturing audio 

Capturing digital video (DV) 























Capturing Analog Video

Use the Capture Editor to transform analog video 
into digitized AVI files (Video for Windows) that can 
be added later to a video production. The resolution
and frame rate of the AVI file are determined by the 
capabilities of the capture hardware. .A capture 
card must be installed on your system.

With the capture card, you can capture video from 
a video camera, television, VCR, or laserdisc 
player. Used with a sound card, the capture 
software provides CD-quality sound with sampling 
rates of up to 44kHz. Depending on your audio 
hardware, audio can be captured at 11kHz, 22kHz, 
or 44kHz, in 8-bit or 16-bit mono or stereo.

To open the Capture Editor:

1. Click the Capture button on the Mode selector.
The Capture Editor console is added below the
Viewscreen.

To capture video:

1. To capture video from an outside source, connect the external device (ie; VCR, camcorder, etc.) to your capture card 
(refer to the instructions provided by the card manufacturer).

2. On the Capture Editor console, click the SETTINGS button. The Capture     Settings   dialog is displayed.

3. Click the SOURCE tab if the Source panel is not already open. Refer to the VIDEO section of the panel. From the 
CAPTURE DEVICE list, select the device, or driver, you will be using to capture the video. From the INPUT list, 
select the input source. Choose between Composite, S-Video, and TV Tuner. If you selected TV Tuner as the input 
source, choose between Cable and Antenna in the CHANNEL list, and then pick a channel. From the STANDARD 
list, specify the appropriate source video standard.

Note:

The Source panel displayed may vary with the video capture card being used. There are two standards for drivers, 
both from Microsoft, that are used with video capture cards. VFW was developed first, and is more commonly used. 
WDM was developed next, and is beginning to gain in popularity. Some capture card manufacturers supply a VFW 
driver for their card, some supply a WDM driver, while others supply both. VFW capture drivers include their own 
dialogs for changing capture card settings. The panel described above applies to the WDM driver.

If you plan to capture audio with your video, refer to the AUDIO section of the Source panel. Specify the CAPTURE 
DEVICE you will be using from the list provided. Click the AUDIO MIXING button to launch the custom dialogs for 
sound mixing provided by your card manufacturer. For a description of these dialogs, consult the documentation 
provided by the manufacturer. If you wish to control your audio CD from within MGI VideoWave IIII, select the 
ENABLE CD CONTROL check box. In this way, you can use the various buttons on the Control panel, located to the 
right of the Viewscreen, to control the CD. If you wish to automatically start your audio CD when you begin capture, 
click the AUTO-START CD DURING CAPTURE button. Note that the control, ENABLE CD DEVICE CONTROL, 
must be selected for this control to be available.

4. Click the VIDEO TEMPLATE tab. A number of video templates are included within the Video     Template   panel. You 
can create your own templates as well. A template consists of a number of predefined settings for such attributes as 
frame size, frame rate, and compression. Select a template from the list provided. A description of each template is 
given. If you wish to create your own template, or edit an existing one, click the CREATE or EDIT buttons, 
respectively. For more information, see Creating     Video     and     Audio     Capture     Templates   

5. If you plan to capture sound with your video, click the AUDIO TEMPLATE tab. A number of audio templates are 
included within the Audio     Template   panel. Select an audio template from the list provided. A description of each 
template is provided. If you wish to create your own template, or edit an existing one, click the CREATE or EDIT 
buttons, respectively. For more information, see Creating     Video     and     Audio     Capture     Templates  

6. In the Capture Settings dialog, click the PREFERENCES button. The Capture     Preferences   dialog is displayed 
consisting of three panels. Use this dialog to set such attributes as time limits, filenames and paths, and Preview 
frame sizes for the capture files. For a complete description of this dialog, see Capture     Preferences  .

7. Start playback of the external device. The video playback is displayed on the Viewscreen.

8. If you wish to adjust the Brightness, Contrast, Color, or Hue of the video, click the SHOW CONTROLS button on the 
Capture Editor console. Use the sliders provided to make your adjustments. When you are finished, click the HIDE 



CONTROLS button to return to the main console.

9. To begin capture, click the VIDEO button or the VIDEO + AUDIO button on the console. The elapsed time is 
displayed below the Viewscreen during capture. The VIDEO or VIDEO + AUDIO button, as the case may be, is re-
labeled STOP.

10. To end capture, click the STOP button, or press the SPACEBAR on the keyboard. The captured file is stored on your 
hard disk according to your settings in the Capture Preferences dialog.



Capturing Still Images

Use the Capture Editor to capture still images in 
bitmap format that can be added later to a video 
production. .A capture card must be installed on 
your system. With the capture card, you can 
capture still images from a video camera, 
television, VCR, or laserdisc player.

To open the Capture Editor:

1. Click the Capture button on the Mode selector.
The Capture Editor console is added below the
Viewscreen.

To capture still images (single frames):

1. To capture a still image (without sound) from an outside source, connect the external device (ie; VCR, camcorder, 
etc.) to your capture card (refer to the instructions provided by the card manufacturer).

2. On the Capture Editor console, click the SETTINGS button. The Capture     Settings   dialog is displayed.

3. Click the SOURCE tab if the Source panel is not already open. Refer to the VIDEO section of the panel. From the 
CAPTURE DEVICE list, select the device, or driver, you will be using to capture the images. From the INPUT list, 
select the input source. Choose between Composite, S-Video, and TV Tuner. If you selected TV Tuner as the input 
source, choose between Cable and Antenna in the CHANNEL list, and then pick a channel. From the STANDARD list,
specify the appropriate source video standard.

Note:

The Source panel displayed may vary with the video capture card being used. There are two standards for drivers, 
both from Microsoft, that are used with video capture cards. VFW was developed first, and is more commonly used. 
WDM was developed next, and is beginning to gain in popularity. Some capture card manufacturers supply a VFW 
driver for their card, some supply a WDM driver, while others supply both. VFW capture drivers include their own 
dialogs for changing capture card settings. The panel described above applies to the WDM driver.

4. In the Capture Settings dialog, click the PREFERENCES button. The Capture     Preferences   dialog is displayed. Click 
the FILE tab, and specify the directory into which the image(s) will be saved. Images are saved in bitmap (.bmp) 
format. In the GENERAL panel, you can specify, if you like, that the captured images be added to the Library and/or 
Storyline automatically after capture. For a complete description of this dialog, see Capture     Preferences  .

5. Start playback of the external device. The video playback is displayed on the Viewscreen.

6. If you wish to adjust the Brightness, Contrast, Color, or Hue of the video, click the SHOW CONTROLS button on the 
Capture Editor console. Use the sliders provided to make your adjustments. When you are finished, click the HIDE 
CONTROLS button to return to the main console.

7. To capture images, click the IMAGE button on the Capture Editor console. Each time the IMAGE button is clicked, the 
video frame currently displayed on the Viewscreen is captured and saved in bitmap format to the directory specified in
the Capture Preferences dialog.



Capturing a Sequence of Frames

Use the Capture Editor to capture a sequence of 
frames that can be added later to a video 
production. .A capture card must be installed on 
your system. With the capture card, you can 
capture frames from a video camera, television, 
VCR, or laserdisc player.

To open the Capture Editor:

1. Click the Capture button on the Mode selector.
The Capture Editor console is added below the
Viewscreen.

To capture a sequence of frames:

1. To capture a sequence of frames from an outside source, connect the external device (ie; VCR, camcorder, etc.) to 
your capture card (refer to the instructions provided by the card manufacturer). Note that you cannot capture sound 
with a sequence.

2. On the Capture Editor console, click the SETTINGS button. The Capture     Settings   dialog is displayed.

3. Click the SOURCE tab if the Source panel is not already open. Refer to the VIDEO section of the panel. From the 
CAPTURE DEVICE list, select the device, or driver, you will be using to capture the images. From the INPUT list, 
select the input source. Choose between Composite, S-Video, and TV Tuner. If you selected TV Tuner as the input 
source, choose between Cable and Antenna in the CHANNEL list, and then pick a channel. From the STANDARD list,
specify the appropriate source video standard.

Note:

The Source panel displayed may vary with the video capture card being used. There are two standards for drivers, 
both from Microsoft, that are used with video capture cards. VFW was developed first, and is more commonly used. 
WDM was developed next, and is beginning to gain in popularity. Some capture card manufacturers supply a VFW 
driver for their card, some supply a WDM driver, while others supply both. VFW capture drivers include their own 
dialogs for changing capture card settings. The panel described above applies to the WDM driver.

4. Click the VIDEO TEMPLATE tab. A number of video templates are included within the Video     Template   panel. You can
create your own templates as well. A template consists of a number of predefined settings for such attributes as frame
size, frame rate, and compression. Select a template from the list provided. A description of each template is given. If 
you wish to create your own template, or edit an existing one, click the CREATE or EDIT buttons, respectively. For 
more information, see Creating     Video     and     Audio     Capture     Templates  

5. In the Capture Settings dialog, click the PREFERENCES button. The Capture     Preferences   dialog is displayed. Click 
the FILE tab, and specify the directory into which the sequence will be saved. Sequences of frames are saved in AVI 
format. In the GENERAL panel, you can specify, if you like, that the captured sequences be added to the Library 
and/or Storyline automatically after capture. For a complete description of this dialog, see Capture     Preferences  .

6. Start playback of the external device. The video playback is displayed on the Viewscreen.

7. If you wish to adjust the Brightness, Contrast, Color, or Hue of the video, click the SHOW CONTROLS button on the 
Capture Editor console. Use the sliders provided to make your adjustments. When you are finished, click the HIDE 
CONTROLS button to return to the main console.

8. On the Capture Editor console, click SEQUENCE. The Sequence Capture Options dialog is displayed.

9. Choose whether to capture a sequence of frames automatically according to a specified time interval, or manually 
using the mouse. Make your selection, and click OK.

Note:

If you choose to capture the sequence automatically, specify a time interval (in seconds) in the value field provided. As
the specified number of seconds elapse, the frame active on the Viewscreen at the time is captured.

Automatic Sequence Capture

If you chose automatic capture in the Sequence Capture Options dialog, the Automatic Sequence Capture dialog is 
displayed. Use this dialog to keep track of the number of frames captured. To end capture, click the END CAPTURE 



button.

Manual Sequence Capture

If you chose manual capture in the Sequence Capture Options dialog, the Manual Sequence Capture is displayed. 
Click the CAPTURE FRAME button each time you wish to capture a frame. To end capture, click the END CAPTURE 
button.



Capturing Audio

Use the Capture Editor to capture audio that can 
be added later to a video production. .A capture 
card must be installed on your system.

With the capture card, you can capture audio from 
a variety of external devices. Used with a sound 
card, the capture software provides CD-quality 
sound with sampling rates of up to 44kHz. 
Depending on your audio hardware, audio can be 
captured at 11kHz, 22kHz, or 44kHz, in 8-bit or 16-
bit mono or stereo.

To open the Capture Editor:

1. Click the Capture button on the Mode selector.
The Capture Editor console is added below the
Viewscreen.

To capture audio:

1. On the Capture Editor console, click the SETTINGS button. The Capture     Settings   dialog is displayed.

2. Click the SOURCE tab if the Source panel is not already open. Refer to the AUDIO section of the panel. Specify the 
CAPTURE DEVICE you will be using from the list provided. Click the AUDIO MIXING button to adjust volume and 
balance. The Audio Input Mixing dialog is displayed. The controls provided depend on the card you have installed on
your system.

Note:

Volume and balance settings can also be adjusted in the Windows® Volume     Control   dialog. To open this dialog, 
double-click the Sound icon on the Windows® taskbar. Alternatively, right-click the Sound icon, and choose Open 
Volume Controls, or select Start>Programs>Accessories>Entertainment>Volume Control in the Windows® menuing 
system.

Before capturing audio, make sure that the desired input device is selected in the Volume Control>Properties dialog. 
To open this dialog,select Properties on the Options menu of the Volume Control dialog. Note that for each device you 
can adjust the volume for audio Playback and Recording.

If you wish to control your audio CD from within MGI VideoWave IIII, select the ENABLE CD CONTROL check box. In 
this way, you can use the various buttons on the Control panel, located to the right of the Viewscreen, to control the 
CD. If you wish to automatically start your audio CD when you begin capture, click the AUTO-
START CD DURING CAPTURE button. Note that the control, ENABLE CD DEVICE CONTROL, must be selected for 
this control to be available.

3. In the Capture Settings dialog, click the PREFERENCES button. The Capture     Preferences   dialog is displayed. Click 
the FILE tab, and specify the directory into which the audio will be saved. Captured audio files are saved in WAV 
format. In the GENERAL panel, you can specify, if you like, that the captured sound files be added to the Library 
and/or Storyline automatically after capture. For a complete description of this dialog, see Capture     Preferences  .

4. Start the playback of the audio device. If you have speakers attached to your system, you should hear sound.

5. To start capture, click the AUDIO button on the Capture Editor console. The elapsed time is displayed below the 
Viewscreen during capture. The AUDIO button is re-labeled STOP.

6. To end capture, click the STOP button on the Capture Editor console, or press the SPACEBAR on the keyboard. The 
captured file is captured and saved according to your settings in the Capture Preferences dialog.









Capturing Digital Video (DV)

Use the Capture Editor to capture digital video that
can be added later to a video production. A capture 
card must be installed on your system. With the 
capture card, you can capture video from a video 
camera, television, VCR, or laserdisc player.

To open the Capture Editor:

1. Click the Capture button on the Mode selector.
The Capture Editor console is added below the
Viewscreen.

With MGI VideoWave IIII, you can control digital devices connected to your IEEE 1394 (FireWire) port. If such a device (a 
DV camcorder, for example) has been connected to your computer, entering Capture mode will present the DV controls on 
the Control panel.

DV camcorders have two modes: Camera and VTR. The correct mode must be set on the camcorder itself. For some 
camcorders, MGI VideoWave IIII can detect this and highlight the correct mode button below the Control panel. However, 
for other camcorders, you may have to click the proper mode button to match that of the camcorder.

    Camera Mode
Camera mode activates the camcorder’s lens. Use this mode for capturing whatever the camera sees in its lens.

    VTR Mode
VTR mode allows capturing from the camcorder’s tape. You may control the camcorder tape playback from within MGI VideoWave 
IIII.

To capture DV in Camera Mode:

1. Turn on the DV camcorder, and specify CAMERA mode.

2. Specify Camera mode in MGI VideoWave III by clicking the CAMERA MODE button. The Viewscreen displays what 
the camcorder sees in its lens.

3. To start capture, click the VIDEO button on the Capture Editor console. MGI VideoWave III will capture whatever the 
camcorder sees in its lens. The elapsed time will be shown at the bottom of the Viewscreen during capture. The 
VIDEO button is re-labeled STOP.

4. To end capture, click the STOP button or press the SPACEBAR on the keyboard. Depending on the settings you 
have chosen in the Preferences dialog, the captured file will be added to the Library, and will be stored on your hard 
disk at the specified location.

About DV Capture in VTR Mode:

VTR mode is used for capturing digital video from your DV camcorder’s tape. You may control the playback of the tape 
from MGI VideoWave III using the DV controls on the Control panel.

The DV controls are similar to the regular edit controls, with a few exceptions. There is no LOOP button, since this function 
is not applicable. The FIRST FRAME and LAST FRAME buttons have been replaced by REWIND and FAST FORWARD, 
respectively.

Use the DV controls to control the DV camera connected to your computer. Click the PLAY button to play the videotape. 
The playback will be shown on the Viewscreen.

Jog Shuttle control

This control makes it easy to find the section of tape you wish to capture. While the tape is playing or paused, drag the 



cursor to the right or left to cue or review the tape, respectively. The Viewscreen displays the playback at a higher speed 
than normal. The further you drag the cursor, the faster the tape is reviewed. Dragging the cursor to the edge of the scale 
reviews the tape at double speed.

Note:

In order to see the tape playback on the Viewscreen when the Fast Forward, Rewind or Jog Shuttle controls are used, the 
tape must be playing or paused. If the tape is stopped, using the controls will rewind or advance the tape without the tape 
contents being shown on the Viewscreen.

To capture from DV tape:

1. Turn on the DV camcorder, and specify VTR mode.

2. Specify VTR mode in MGI VideoWave III by clicking the VTR MODE button. The Viewscreen displays what the 
camcorder sees in its lens.

3. Click the PLAY button to play the camcorder’s tape. The tape is played back on the Viewscreen.

4. If necessary, use the FAST FORWARD, REWIND, and JOG SHUTTLE controls to find the section of tape you wish 
to capture.

5. To start capture, click the VIDEO button on the Capture Editor console. The elapsed time will be shown at the bottom
of the Viewscreen during capture. The VIDEO button is re-labeled the STOP button.

6. To end capture, click the STOP button or press the SPACEBAR on the keyboard. Depending on the settings you 
have chosen in the Preferences dialog, the captured file will be added to the Library, and will be stored on your hard 
disk at the specified location.



Capture Preferences

Use this dialog to specify capture preferences. The dialog consists of three panels.

To open the dialog:

1. Click the Capture button on the Mode selector. The Capture Editor console is opened below the Viewscreen.

2. On the Console, click the SETTINGS button. In the Capture Settings dialog displayed, click the PREFERENCES 
button.

General tab 

Add files to Library
Select this control to add the captured file to the Library as soon as the capture process is finished.

Add files to Storyline
Select this control to add the captured file to the Storyline as soon as the capture process is finished.

Limit capture to (seconds)
Select this control to limit your capture to a specified time interval, expressed in seconds. Specify the time interval in 
the value field provided.

Disable Video Overlay
Select this control if you experience problems with video preview. Not all capture cards support overlay. Or, it may be 
that your video card is not compatible with your capture card. The purpose of overlay is to provide smooth video 
preview, to the extent that the video is played in the Viewscreen as it is seen by the capture device. In overlay mode, 
data is transferred from the capture source directly to video memory, bypassing the bus. When overlay is disabled, 
the capture device generates frames, and sends them to the video card via the bus.

File tab 

Capture Filename
Select this control to automatically generate file names for your captures. In the text field provided, specify a file 
name, or more specifically a file prefix. Each capture you perform is saved according to a numerical sequence 
prefixed by the specified text string. One example of this is: My Birthday_001, My Birthday_002, My Birthday_003, 
etc.

Capture Directory
Browse your system, and specify the path to where the captured files are to be stored.

Preview tab 

Size
A list of predefined frame sizes. These sizes are provided for preview purposes only. Your selection affects only what 
you see in the Viewscreen; it does not affect the actual size during capture.

Disable Video Overlay
Select this control if you experience problems with video preview. Not all capture cards support overlay. Or, it may be 
that your video card is not compatible with your capture card. The purpose of overlay is to provide smooth video 
preview, to the extent that the video is played in the Viewscreen as it is seen by the capture device. In overlay mode, 
data is transferred from the capture source directly to video memory, bypassing the bus. When overlay is disabled, 
the capture device generates frames, and sends them to the video card via the bus.

Preview While Capturing
Select this control to view the video in the Viewscreen as it is being captured.





Capture - an overview

The MGI VideoWave III video/audio capture and editing software transforms analog video into digitized .AVI files (Video for 
Windows) that you can play back on your computer. The resolution and frame rate will depend on the capabilities of your 
capture hardware.

Use MGI VideoWave to capture and edit video from a video camera, television, VCR, or laserdisc player. Used with a 
sound card, the capture software provides CDquality sound with sampling rates of up to 44kHz. Depending on the audio 
hardware, you can capture audio at 11 kHz, 22 kHz, or 44 kHz, in 8bit or 16bit mono or stereo.

MGI VideoWave also offers a full range of video and audio editing features, allowing you to play back captured video from 
your hard disk, or view live video before capturing.

MGI VideoWave Capture Features

· Motion video and audio capture.

· Still image and Image Sequence capture.

· Live video monitoring – allows you to preview video before capturing.

· Automatic Uncompressed option – maintains image quality of captured, uncompressed video.

MGI VideoWave captures video, audio, or both together. You can preview the incoming video to select frames for capture, 
and adjust video quality or resolution before capturing. MGI VideoWave provides four ways to capture:

Video

Capture fullmotion video (with optional audio), and save it to an .AVI file.

Singleframe capture

Capture single images in Bitmap (BMP) format.

Multiframe capture

Select a sequence of frames to capture, and save it to an .AVI file.

Video Tips

In many cases, you can use MGI VideoWave's default capture settings for much of your work. But if you want to get the 
most out of digital video, here are a few techniques and hints for creating, manipulating, and displaying your files.

How We See Things

People perceive the visual world in the following sequence:

· first, we see motion

· then brightness

· then color

· then resolution

The fact that color and resolution are less important to the viewer (especially for a short clip) means that we can often 
capture at a lower resolution to save memory, and obtain virtually the same effect as if we had captured at a higher 
resolution.

Capturing Audio

Capture is the step where options matter most. Audio capture, in particular, can needlessly eat up lots of disk space.

· Stereo audio takes up twice the storage room of monaural audio. If your audio track is stereo and consists mainly of 
dialogue (rather than music) consider changing it to mono.

· Sound sampled at a frequency of 22kHz is twice the size of the same sound sampled at 11kHz. Music is usually better 
sampled at a higher frequency; speech suffers little when it's sampled at 11 kHz.

· Audio sample size (in bits) affects the audio's dynamic range and signaltonoise ratio. 16bit sample size is equivalent to 
that used in CD playback, and is preferred for music; 8bit is fine for dialogue. Keep in mind that good quality audio 
depends on the source – poor microphones or a dirty tape playback head can produce disappointing results. Audio can 
have a large impact, so if it's important to your video, you may want to use the 16bit setting to maintain fidelity and 
minimize noise, while ensuring the capture source is providing the highest possible performance.



Capturing Video

The person receiving your file may have softwareonly playback, in a smaller window.

· If you capture in a larger window size that is later reduced, your file may exhibit "jaggies" ("stairstep" effects on diagonal 
lines). For most desktop presentations, quarterscreen (320x240) is the best size.

Compression

A key frame is a single video frame that contains much of the image information of subsequent frames, and is therefore 
used as a reference to compressing following video frames. In other words, a keyframe contains enough redundant 
information to produce a copy of itself for the next few frames instead of having to read new information for all frames, 
saving data and disk space. The key frame is the baseline against which MGI VideoWave compares other frames for 
differences. The Key Frame option specifies the rate at which the clip is sampled for key frames.

· Generally, set the Key Frame option to match the playback rate of the clip. For example, if you have set the frame rate 
of your clip to 15 frames per second (fps), set the Key Frame option to 15.

· Key Frame provides increased compression and playback speed, but it can slow access to individual frames in the clip. 
If you want to view the clip without skipping to different parts, set the Key Frame option higher than the frame rate.

Data Rate

The data rate is the speed, in kilobytes per second (KBps), at which the playback computer can transfer data from disk to 
screen.

· Use this option to specify the anticipated data transfer rate of the playback computer system.

· You will speed up compression if you do not select this option when you are editing.

· When producing a file for print to tape, set the Data Rate to the same value used during capture, and set Quality to 
100%.

Capturing to memory

Capturing to your computer's random access memory (RAM) is faster than capturing to disk. If you do not have enough 
free memory for capture, use a dedicated hard disk or create a separate partition on your hard disk drive for capturing 
video.

Recording to a fragmented hard disk can reduce the capture frame rate. To defragment your hard disk drive use a 
defragmenting utility such as Norton Utilities Speed Disk, or in Windows 95, use the Disk Defragmenter found in 
Accessories/System Tools.

Pre-allocating file space

If your hard disk is not completely defragmented, you should preallocate disk space for your capture file. When you enter a 
size – 10 Megabytes, for example –MGI VideoWave reserves 10 Megabytes of contiguous (unfragmented) disk space, so 
that you can capture up to 10 Megabytes without disk problems.

· If you capture less than the allocated amount, the file will still occupy 10 Megabytes on your disk.

· If you capture more than the amount you've allocated, MGI VideoWave will continue recording until the available disk 
space is consumed, although performance may be affected.



Creating Video and Audio Capture Templates

VIDEO TEMPLATES:

Click the CREATE button on the Video     Template   panel of the Capture Settings dialog to create your own video template. 
The Create     Video     Capture     Template   wizard is provided to guide you through the process.

To create a video template:

1. Assign a name to your new template in the TEMPLATE NAME field.

2. If you wish, record a description of your new template for future reference. A large TEMPLATE DESCRIPTION text 
field is provided for this purpose.

3. Select a FILE TYPE from the list provided. A description of each type is given.

4. Click the NEXT button to advance the wizard.

5. In the second panel displayed, set values for the following attributes:

VIDEO

Video Format

Click this button to specify the frame size and color depth of capture. Larger frame sizes create more video data and 
may cause more frames to be dropped during capture. Image dimensions can be set as well as the video 
compression used for capture if onboard compression hardware is present.

Frame Rate

A value specifying the capture frame rate. If you intend to produce for computer or internet display, you may wish to 
select a low frame rate to save disk space. If you intend to output to tape or play back on TV, specify a frame rate of 
29.97 frames per second (NTSC) or 25 frames per second (PAL).

RECOMPRESSION

Compressor

Click the SELECT button if your capture board does not include onboard compression hardware. Use the dialog 
displayed to specify the preferred quality and method of compressing the raw video data before it is written to the 
hard disk.

SYNCHRONIZATION

Synchronization

Analog video is transformed into AVI files during the capture process. AVI files include two data streams, one video 
and one audio. Because data may be transfered at different rates along the two streams , this feature allows you to 
specify the “master” stream to which the capture is synchronized. Video synchronization is the default setting.

6. Click the FINISH button.

AUDIO TEMPLATES:

Click the CREATE button on the Audio     Template   panel of the Capture Settings dialog to create your own audio template. 
The Create     Audio     Capture     Template   is dialog displayed.

To create an audio template:

1. Assign a name to your new template in the TEMPLATE NAME field.

2. If you wish, record a description of your new template for future reference. A large TEMPLATE DESCRIPTION text 
field is provided for this purpose.

3. Set values for the following attributes:

Sample Rate

Sound sampled at a frequency of 22kHz is twice the size of the same sound sampled at 11kHz. Music is usually 
better sampled at a higher frequency; speech suffers little when it's sampled at 11 kHz.

Bits per Sample



Audio sample size (in bits) affects the audio's dynamic range and signaltonoise ratio. A 16bit sample size is 
equivalent to that used in CD playback, and is preferred for music; 8bit is fine for dialogue. Keep in mind that good 
quality audio depends on the source – poor microphones or a dirty tape playback head can produce disappointing 
results. Audio can have a large impact, so if it's important to your video, you may want to use the 16bit setting to 
maintain fidelity and minimize noise, while ensuring the capture source is providing the highest possible 
performance.

Channels

Stereo audio takes up twice the storage room of monaural audio. If your audio track is stereo and consists mainly of 
dialogue (rather than music) consider changing it to mono.

4. Click the SAVE button.







Considerations before producing your video

Video files consume large amounts of disk space, and can therefore be difficult to store, manipulate, and distribute.

Video compression reduces the size of these files to manageable levels by encoding the video frame data. When the 
encoded frames are required for playback or editing, they are decoded (decompressed) back into their original form.

Compression can also improve playback. Computers are limited by their data rate – how fast they can transfer data from 
the disk to memory and display. If a video file requires a higher data rate than the computer can provide, it will not play 
back properly. It may appear jumpy and skip frames, and audio may also suffer. Compression reduces the video file's data 
rate which improves playback quality.

Other factors also affect the data rate: frame size, frame rate,and audio format.

Frame Size

Studio-quality frame size for digital video is 720 x 480 (NTSC) or 720 x 576 (PAL/SECAM). With consumer equipment, 
however, horizontal sample rates can be reduced resulting in a frame size of 320 x 480 (NTSC) or 384 x 576 
(PAL/SECAM). This frame size still contains both fields of the interlaced video signal making it suitable for tape to tape edit.
When the goal is to create video for playback on the computer screen, non-interlaced capture should be used. This is best 
achieved by capturing just one of two fields resulting in a frame size of 320 x 240 (NTSC) or 384 x 288 (PAL/SECAM).

For Internet use, the standard frame size is 160 x 120. This size reduces memory requirements and download times over 
phone lines.

Frame Rate

Frames per second (fps). The standard for TV is 29.97 fps (NTSC) or 25 fps (PAL, SECAM). For tape to tape edit this exact
number must be used. For other media, like CDs and the Internet, 15 fps is usually acceptable and requires less storage 
space.

Audio Format

Sound sampled at a frequency of 22 kHz is twice the size of the same sound sampled at 11 kHz. Music is usually better 
sampled at a higher frequency; speech suffers little when it is sampled at 11 kHz.

Audio sample size (in bits) affects the audio's dynamic range and signaltonoise ratio. 16bit sample size is equivalent to that
used in CD playback, and is prefered for music; 8bit is fine for dialogue.

Stereo audio takes up twice the storage room of monaural audio. If your audio track is stereo and consists mainly of 
dialogue (rather than music) consider changing it to mono.

See Also

How to save and produce a video 





MPEG Format

MPEG is an acronym for Moving Pictures Experts Group. MPEG is a group of people convened by the ISO (International 
Standards Organization) to generate standards for digital video and audio compression. In particular, they define a 
compressed bit stream, which in turn defines a decompressor. The MPEG group meets roughly four times a year.

The MPEG1 standard defines a bit stream for compressed video and audio optimized to fit into a bandwidth (data rate) of 
1.5 Megabits per second (Mbits/s). This rate is special because it is the data rate of uncompressed audio CDs. The 
standard is in three parts, video, audio, and systems, where the last part gives the integration of the audio and video 
streams with the proper time stamping to allow synchronization of the two. The MPEG2 standard defines a bit stream for 
video and audio coded at around 3 to 10 Mbits/s, and yields higher resolution and quality.
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Using Help

If you clicked an icon in the Mode selector, you can access the Help topic specific to the selected mode by pressing the 
[F1] key.

To access the Help system's Table of Contents or Index, click the Menu button at the top of the Toolbar, and select Topic 
Search from the Help menu displayed. Alternatively, press the [F1] key anytime the Mode selector is inactive.

See

Topic Search 



File formats you can use

MGI VideoWave accepts digital Video, Audio, and Graphic Image files, in several different formats:

File Type Format Extension

Video Audio Video Interleave .AVI

MPEG-1 .MPG, .MPEG

MPEG-2 .MPG, .MPEG, .MPEG2, .M2P, .M2S, .MPV

Graphic Image Windows Bitmap .BMP

Tagged Image File .TIF
(without LZW compression)

Targa .TGA

JPEG .JPG

PaintBrush .PCX

Encapsulated PostScript .EPS

Windows Metafile .WMF

FlashPix .FPX

Mac Paint .MAC

Microsoft Paint .MSP

Kodak PhotoCD .PCD

Mac Pict .PIT

Portable Network Graphics .PNG

Adobe PhotoShop .PSD

Audio Waveform Audio .WAV

Production MGI VideoWave Production .SBD

MGI VideoWave Scene .SCN

Library MGI VideoWave Library .VWL

After editing and assembling your source material, your finished MGI VideoWave production will be an AVI or MPEG file.



License Agreement

Notice: MGI Software Corp. (MGI) licenses the enclosed software to you only upon the condition that you accept all of the terms 
contained in this license agreement. Please read the terms carefully. If you do not agree with these terms, then MGI is unwilling to 
license the software to you, in which event you should return the full product with proof of purchase to the dealer from whom it was 
acquired.

LICENSE AND WARRANTY:

The software which accompanies this license (the “software”) is the property of MGI or its licensors and is protected by copyright 
law. While MGI continues to own the Software, you will have certain rights to use the Software after your acceptance of this license. 
Except as may be modified by license addendum which accompanies this license, your rights and obligations with respect to the use
of this Software are as follows:

You may:

1. use one copy of the Software on a single computer; if the media which you received in this package contains more than one 
language version of the Software and/or multiple Software titles, you are only licensed for one language version per Software 
title contained on the media (you may not make copies of different language versions) and you may not transfer such other 
versions to another person or allow another person to use such other versions;

2. make one copy of the Software for archival purposes, or copy the software onto the hard disk of your computer and retain the 
original for archival purposes;

3. use the Software on a network, provided that you have a licensed copy of the Software for each computer that can access the 
Software over that network;

4. after written notice to MGI, transfer the Software on a permanent basis to another person or entity, provided that you retain no 
copies of the Software and the transferee agrees to the terms of this agreement; and

5. if a single person uses the computer on which the Software is installed at least 80% of the time, then after returning the 
completed product registration card which accompanies the Software, that person may also use the Software on a single home 
computer.

You may not:

1. copy the documentation which accompanies the Software;

2. sublicense, rent or lease any portion of the Software;

3. reverse engineer, decompile, disassemble, modify, translate, make any attempt to discover the source code of the Software, or 
create derivative works from the Software; or

4. use a previous version or copy of the Software after you have received a disk replacement set or an upgraded version as a 
replacement of the prior version, unless you donate the previous version of an upgraded version to a charity of your choice, and 
such charity agrees in writing that it will be the sole end user of the product, and that it will abide by the terms of this agreement. 
Unless you so donate a previous version of an upgraded version, upon upgrading the Software, all copies of the prior version 
must be destroyed.

Limited Warranty:

MGI warrants that the media on which the Software is distributed will be free from defects for a period of sixty (60) days from the 
date of delivery of the Software to you. Your sole remedy in the event of a breach of this warranty will be that MGI will, at its option, 
replace any defective media returned to MGI within the warranty period. MGI does not warrant that the Software will meet your 
requirements or that operation of the Software will be uninterrupted or that the Software will be error-free.

THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH 
VARY FROM STATE TO STATE.

Disclaimer of Damages:

REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT WILL 
MGI BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL, INDIRECT OR SIMILAR DAMAGES, INCLUDING ANY LOST 
PROFITS OR LOST DATA ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE EVEN IF MGI HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL 
DAMAGES SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

IN NO CASE SHALL MGI’S LIABILITY EXCEED THE PURCHASE PRICE FOR THE SOFTWARE. The disclaimers and limitations 



set forth above will apply regardless of whether you accept the software.

U.S. Government Restricted Rights: 

RESTRICTED RIGHTS LEGEND. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in 
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs 
(c) (1) and (2) of the Commercial Computer Software-Restricted Rights clause at 48 CFR 52.227-19, as applicable, MGI Software 
Corporation, 50 West Pearce Street, Richmond Hill, Ontario, Canada L4B 1C5.

General: 

This Agreement will be governed by the laws of the Province of Ontario, Canada. This Agreement may only be modified by a license
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Shooting Video – tips and techniques

1.      Preplan

· Try to preplan a list of shots that you want to film.
· Include a variety of shots, i.e. close ups, medium shots, wide shots, establishing shots. Short forms used for these types of 

shots include: CU (close up), MS (medium shot), WS (wide shot), MCU (medium close up), ES (establishing shot)
· Bring the following equipment with you on your shoot.

Video camera
Extra battery
Tripod
Lens cleaner
Camera bag
A few extra video tapes
Microphone
Movie light and stand
Extension cord
Pencil and paper
Gaffer tape

· To keep the audience’s attention, use the general rule of 6 seconds per shot. These 6 seconds represent the finished time in 
the final production.

2.      Camera & Equipment

· A camcorder that has the ability to adjust to most lighting conditions is ideal. 
· Some lighting conditions that you might encountered are low light situations, such as filming indoors, where you might need 

to use a fill light.    You may also encounter very bright light conditions, such as outdoor light.    In this case you will have to 
use some sort of light diffusion.

· Auto focus , auto exposure, back light adjustment useful
· VHS, Hi8, Mini DV are all acceptable formats.
· Camcorders that let you control the exposure are an added bonus, thus giving you additional control over the scene you are 

filming.
· An option that most camcorders have is the ability to add on a video light.    This will be very helpful for when you shoot in low 

light situations.
· Consider the use of a microphone.    You may choose to use a wireless, lapel or hand held microphone.
· Place a microphone on the subject if possible. This will ensure that you have a clear sound track if the subject is more than 

10 feet away from the camera.
· Invest in a good quality tripod.    This will help when you are filming indoors.
· DV cameras record all your footage digitally on one small cassette.
· DV cameras have the best picture quality and can be dubbed over and over, with no loss of picture quality.    
· DV cameras have a variety of useful options that let you manually override the automatic exposure settings. 

3.      Video Tapes

· Use a high quality tape.    This type of tape indicates that there are more magnetic particles on it. Hi 8, and Super VHS give a 
sharper image that regular VHS and 8mm tapes. Near broadcast quality tapes are Mini DV tapes and provide the best 
possible picture.

4.      Lighting

· For outdoor lighting, try to place the subject toward the sun if possible and place yourself in front of the subject.    It is best to 
film in the early morning or late afternoon to get a golden effect on your video.    
Filming at high noon creates narrower or harder shadows on the subject’s face.    
It is best to use some sort of light diffusion if you are filming at high noon if possible.    For i.e., shoot under the shade of a tree
if you are filming portraits.

· For indoors:    Try to use as much available light as possible.    
You may also need to enhance the available light with the use of a camera light.    This will ensure that you properly expose 
the subject.
Once you get additional experience with lights you may want to consider using lights on stands if you have control over what 



you are filming.

CATAGORIES    

Wedding

Total running time should be between 5-7 minutes.    It is acceptable to shoot as much footage as you want, but keep in mind that
we want to edit this down to make a short, entertaining movie.    It is essential to keep the audience’s attention span.
Things you may wish to film include: the bride getting ready in the mirror, bridesmaid, wedding party vehicle, church, parents of 
the couple, audience at church, bride down the aisle.    Also, tape the exchanging of vows, reception party, eating dinner at hall, 
cutting of the cake, dancing etc.

Child Birthday

Total running time should be between 5-7 minutes.    It is acceptable to shoot as much footage as you want, but keep in mind that
we want to edit this down to make a short, entertaining movie.    It is essential to keep the audience’s attention span.
Things you may wish to film include: invitations, balloons at the door, decorations in the home, guests arriving with gifts, birthday 
cake, candles on the cake, party in full swing, entertainer (if any), children singing songs, opening of gifts, reaction shot of adults,
lighting birthday candles, singing happy birthday, blowing out of candles.

Adult birthday

Total running time should be between 5-7 minutes.    It is acceptable to shoot as much footage as you want, but keep in mind that
we want to edit this down to make a short, entertaining movie.    It is essential to keep the audience’s attention span.
Things you may wish to film include: planning of surprise birthday party, friends decoration apartment/house, film cake and 
balloons, everyone hiding in the room, front door as the adult arrives, the surprise on his face, singing of happy birthday, candles 
on cake, adult blowing out candles, party in full swing.

Trade Show

Total running time should be between 5-7 minutes.    It is acceptable to shoot as much footage as you want, but keep in mind that
we want to edit this down to make a short, entertaining movie.    It is essential to keep the audience’s attention span.
Things you may wish to film include: establishing shot of building or convention hall, film visitors entering the exhibit hall, film 
individual booths, get close ups of product or services which are being sold, film the spokesperson and demo station. 



Sample Storyboards

The sample storyboards included with the program are .SBD files that you can load for ideas. Each storyboard consists of a 
number of still images (tiffs). Each image is a single phrase describing one shooting idea. The images are categorized according 
to the following subjects: Baseball; Birthday; Corporate; Graduation; and Wedding, so that you can choose one that most closely 
matches your needs.
Most categories contain a sample AVI as the first scene, that you can use as an introduction to place credits on, or just to leave 
as it is. Subsequent scenes on the storyboard include phrases such as 'Closeup (CU) of birthday cake' and 'Wide shot of guests'.
The storyboard is essentially a 'check-list' of video shooting ideas, and contains a few transitions as well.
Use the one-line phrases in each scene as a basis for constructing your own storyline. We suggest that you keep the sample 
SBD file loaded, and then replace each image in the scene with your own video footage scene. When you are finished, the 
storyline's descriptive still images will have been replaced entirely with the your own video scenes.
You can find these sample storyboards as follows:
.\MGI\VideoWave\MEDIA\Storyboards




